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 Иллюстрации в настоящем руководстве даны только для справки и могут отличаться в зависимости 

от версии или модели изделия. Скриншоты в настоящем руководстве могут быть изменены с целью 

соответствия конкретным требованиям и предпочтениям пользователей. Поэтому некоторые 

примеры и функции, приведенные здесь, могут отличаться от отображаемых на вашем мониторе. 

 Настоящее руководство является пособием для нескольких моделей изделия и поэтому не 

предназначено для конкретного изделия. 

 Из-за факторов неопределенности, таких как физическая среда, может существовать несоответствие 

между фактическими и рекомендуемыми значениями, указанными в настоящем руководстве. 

Нашей компании принадлежит единоличное право толкования информации в руководстве. 

Защита окружающей среды 

Настоящее изделие было разработано в соответствии с требованиями в области защиты окружающей 

среды. Для обеспечения надлежащего хранения, использования и утилизации настоящего изделия 

соблюдайте национальные законы и нормы. 

Символы 

Символы, приведенные в следующей таблице, могут использоваться в настоящем руководстве. 

Внимательно следуйте указаниям, которыми сопровождаются символы, во избежание опасных 

ситуаций и надлежащего использования изделия. 

Символ Описание 

 ВНИМАНИЕ! 
Обращает внимание на важные инструкции по технике безопасности и 
ситуации, которые могут привести к травмам. 

 ПРЕДУПРЕЖДЕНИЕ! 

Сообщает, что пользователь должен быть осторожным и о том, то 
ненадлежащие операции могут привести к повреждению изделия или к 
сбоям в его работе. 

 ПРИМЕЧАНИЕ! 
Дополнительная информация, которая может быть полезна при 
использовании продукта. 
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1  Подключение к сети 

Прежде чем получить доступ к сетевой камере (называемой также IP-камерой или IPC) с 

компьютера, необходимо подключить камеру к ПК непосредственно с помощью сетевого кабеля или 

через коммутатор/маршрутизатор. 

 

Чтобы подключить сетевые интерфейсы сетевой камеры к ПК, используйте кабель с экранированными 

витыми парами (STP). 

 

Чтобы подключить сетевые интерфейсы камеры к коммутатору или маршрутизатору, используйте 

кабель с экранированными витыми парами (STP). 

2  Вход в систему 

Подготовка 

После завершения установки в соответствии с кратким руководством подключите камеру к источнику 

питания, чтобы она запустилась. После запуска камеры вы можете получить доступ к ней с помощью 

клиента, установленного на ПК с веб-браузером или клиентским программным обеспечением 

EZStation. Рекомендуемый веб-браузер: Internet Explorer (IE). Для получения дополнительной 

информации о EZStation см. Руководство пользователя EZStation. 

Ниже показан пример использования браузера IE в операционной системе Microsoft Windows 7. 

Проверка перед входом в систему 

 Камера работает нормально. 

 Сетевое соединение между ПК и камерой в норме. 

 На используемом вами ПК установлена версия браузера Internet Explorer 8.0 или выше. 

 Установлено разрешение 1440 x 900 (необязательно). 

Network cable

IPC PC

IPC PCSwitch or Router

Network cable Network cable

Сетевой кабель 

Сетевой кабель 

Коммутатор или маршрутизатор ПК IP-камера 

ПК IP-камера 

 Сетевой кабель 
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Добавьте IP-адрес как адрес надежного сайта 

 

 

1

2

http://192.168.0.13

3

4

5

6

Clear the check box

7

Снимите флажок 
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ПРИМЕЧАНИЕ! 

IP-адрес 192.168.0.13/192.168.1.13 в этом примере является IP-адресом по умолчанию. Замените его 
фактическим адресом вашей камеры, если он был изменен. 

 

Изменение параметров управления доступом пользователей (необязательно) 

Прежде чем вы получите доступ к камере, выполните следующие шаги, чтобы задать для параметра 

User Account Control Settings значение Never notify. 

 

Вход в веб-интерфейс 

Статический IP-адрес камеры по умолчанию: 192.168.1.13 или 192.168.0.13, а маска подсети по 

умолчанию: 255.255.255.0. 

Протокол DHCP включен по умолчанию. Если в сети используется сервер DHCP, IP-адрес вашей 

камеры назначается в динамическом режиме, и вы должны использовать корректный IP-адрес для 

входа в систему. Чтобы узнать динамический IP-адрес вашей камеры, используйте клиент EZStation. 

Ниже показан пример входа в систему в браузере IE. 

1. Перейдите на страницу входа, введя IP-адрес вашей камеры в строку поиска. 

 

2. Если вы входите в систему впервые, следуйте экранным инструкциям и установите ActiveX. 

Чтобы завершить установку, необходимо закрыть браузер. 

1

2

3

4
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ПРИМЕЧАНИЕ! 

 Чтобы вручную загрузить ActiveX, введите в строке поиска http://IP address/ActiveX/Setup.exe 
и нажмите Enter. 

 Пароль по умолчанию используется только для первого входа в систему. Для обеспечения 
безопасности учетной записи измените пароль после первого входа в систему. Рекомендуем 
установить надежный пароль (не менее восьми символов). 

 Камера имеет защиту от незаконного доступа, ограничивающую число неудачных попыток 
входа. После шести последовательных неудачных попыток входа, камера автоматически 
блокируется на десять минут. 

 

3. Введите имя пользователя и пароль, а затем нажмите на кнопку Login. Для входа в первый раз 

используйте имя пользователя по умолчанию admin и пароль 123456. 

 Если вы войдете в систему, выбрав Live View, тогда после входа будет отображаться видео в 

режиме реального времени. В противном случае вам потребуется запустить эту функцию 

вручную в окне живого просмотра. 

 Если вы войдете в систему, выбрав опцию Save Password, вам не нужно будет вводить пароль 

каждый раз при входе. Однако, чтобы обеспечить высокий уровень безопасности, выбирать 

опцию Save Password не рекомендуется. 

 Чтобы очистить текстовые поля Username и Password, а также снять флажок Save Password, нажмите 

Reset.  

Общие сведения о веб-интерфейсе 

Когда вы входите в веб-интерфейс, по умолчанию открывается окно просмотра в реальном времени. 

Следующие иллюстрации представлены в качестве примера. 

 

№ Описание 

1 Меню 

2 

Область наблюдения PTZ-камеры 

Примечание. 

Эта область доступна для купольных и обычных PTZ-камер. 

3 Окно живого просмотра 

4 Панель инструментов для живого просмотра 

1

2

3

4
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Начальная настройка 

После входа в интерфейс устройства выполните начальную настройку. 

Позиция Описание 

1. Задание TCP/IP-адреса для 
устройства. 

Повторно задайте IP-адрес и сетевые параметры устройства 
в соответствии с фактической конфигурацией сети. 

2. Выйдите из системы и войдите 
снова в сеть, используя новый 
IP-адрес. 

- 

3. Установка системного времени. Установите фактическое системное время. 

4. Настройка сервера управления 
(необязательно). 

Настройте сервер управления в соответствии с фактической 
конфигурацией сети. 

5. Настройка сервера для хранения 
фотографий (необязательно). 

Настройте сервер для хранения фотографий в соответствии 
с фактической конфигурацией сети. 

6. Настройка экранного интерфейса. 
Выберите информацию, которая должна отображаться на 
экране, например, время. 

7. Управление пользователями 
(необязательно). 

Измените пароль по умолчанию и добавьте пользователей 
по мере необходимости. 

 

После окончания начальной настройки вы можете смотреть видео в реальном времени. При 

необходимости настройте другие параметры. 

 
ПРИМЕЧАНИЕ! 

 Параметры и диапазоны значений, отображаемые в интерфейсе живого просмотра, зависят 
от конкретных моделей. Для получения подробных данных см. фактический веб-интерфейс. 

 Параметры, отображаемые серым цветом, не подлежат изменению. Чтобы узнать 
фактические параметры, см. веб-интерфейс. 

 После первого входа в систему рекомендуется изменить пароль. Для получения дополнительной 
информации об изменении пароля см. Безопасность. 

 

3  Настройка параметров 

Локальные параметры 

Задайте локальные параметры для своего ПК. 

 
ПРИМЕЧАНИЕ! 

Локальные параметры могут изменяться в зависимости от моделей. Для получения подробных данных 
см. фактический веб-интерфейс. 

 

1. Выберите команды Setup > Common > Local Settings. 

https://tm.by 
Интернет-магазин



6 

 

2. Измените настройки в соответствии со своими требованиями. В следующей таблице описаны 

некоторые из главных параметров. 

Параметр Описание 

Intelligent 
Mark 

Untriggered 
Target 

При включении камера отображает экранный знак на цели (например, 
на лице, когда включена функция обнаружения лиц) и отслеживают его. 

Video 

Processing 
Mode 

 Приоритет реального времени: рекомендуется при хорошем 
состоянии сети. 

 Приоритет плавности: рекомендуется, если требуется 
кратковременная задержка для живого видео. 

 Сверхнизкая задержка: рекомендуется, если требуется минимальная 
задержка для живого видео. 

Protocol 
Установите протокол, используемый для передачи потоков 
медиаданных, которые будут декодироваться ПК. 

Record and 
Snapshot 

Recording 

 Подраздел по времени: продолжительность зарегистрированного видео 
для каждого файла записи на компьютере. Например, 2 минуты. 

 Подраздел по размеру: Размер каждого файла записи, сохраняемого 
на компьютере. Например, 5 MБ. 

Record 
Overwrite 

 Перезапись: когда выделенное хранилище на компьютере 
заполнено, камера удаляет старые файлы записи, чтобы освободить 
место для новых. 

 Полный останов: когда выделенное хранилище на компьютере 
заполнено, запись останавливается автоматически. 

 

3. Нажмите Save. 
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Настройка сети 

Интерфейс Ethernet 

Измените настройки связи, такие как IP-адрес камеры, чтобы камера могла поддерживать связь с 

другими устройствами. 

 
ПРИМЕЧАНИЕ! 

 После изменения IP-адреса, вы должны войти в систему с новым IP-адресом. 

 Настройки сервера доменных имен (DNS) применяются в том случае, когда доступ к 
устройству осуществляется с помощью доменного имени. 

 

Статический IP-адрес 

1. Нажмите Setup > Network > Network. 

  

2. В выпадающем списке Obtain IP Address выберите пункт Static. 

3. Введите IP-адрес, маску подсети и адрес шлюза по умолчанию. Удостоверьтесь, что IP-адрес 

камеры уникален в сети. 

4. Нажмите Save. 

PPPoE 

 
ПРИМЕЧАНИЕ! 

Данная функция не поддерживается некоторыми моделями. Для получения подробных данных см. 
фактическую модель. 

 

Если камера подключается к сети по протоколу двухточечного соединения через Ethernet (PPPoE), 

необходимо выбрать PPPoE в качестве способа получения IP-адреса. 
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1. Нажмите Setup > Network > Network. 

 

2. В выпадающем списке Obtain IP Address выберите пункт PPPoE. 

3. Введите имя пользователя и пароль, предоставленные поставщиком услуг сети Интернет (ISP). 

4. Нажмите Save. 

DHCP 

По умолчанию для камеры активирован протокол динамической конфигурации хоста (DHCP). Если в 

сети развернут сервер DHCP, камера может автоматически получить IP-адрес от сервера DHCP. 

Чтобы вручную настроить DHCP, выполните перечисленные ниже шаги. 

1. Нажмите Setup > Network > Network. 

 

2. В выпадающем списке Obtain IP Address выберите пункт DHCP. 

3. Нажмите Save. 

IPv6 

1. Нажмите Setup > Network > Network. 
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2. По умолчанию для режима IPv6 установлена опция Manual. 

3. Введите адрес IPv6, задайте длину префикса и шлюз по умолчанию. IP-адрес должен быть 

уникальным в сети. 

4. Нажмите Save. 

Wi-Fi 

 
ПРИМЕЧАНИЕ! 

Эта функция не поддерживается некоторыми моделями. Для получения подробных данных см. фактическую 
модель. 

1. Нажмите Setup > Network > Network. Откройте вкладку Wi-Fi. 

 

2. Выберите Sniffer. 

3. Нажмите Save. 

Некоторые устройства могут искать сети Wi-Fi и подключаться к ним. 

1. Выберите Setup > Network > Network. Выберите Wi-Fi для Wi-Fi Mode. 

 

2. Отобразится уровень сигнала. Включите Adaptive Streams. На странице показано, что есть другие 

сети Wi-Fi. Чтобы снова выполнить поиск сетей Wi-Fi , нажмите Search. 

3. Нажмите имя (SSID) в списке сетей Wi-Fi. Отобразится информация о соответствующей сети. 
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4. Нажмите Save. 

5. Если для режима Wi-Fi Mode выбрано значение Wi-Fi Hotspot, камера может функционировать 

как точка доступа Wi-Fi для других устройств. 

 

6. Нажмите Save. 

Порт 

 
ПРИМЕЧАНИЕ! 

Данная функция не поддерживается некоторыми моделями. Для получения подробных данных см. 
фактическую модель. 

1. Нажмите Setup > Network > Port. 

 

2. Задайте соответствующие номера портов. 

3. Нажмите Save. 

FTP 

После настройки FTP вы сможете загружать снимки с сетевых камер на указанный сервер FTP. 

Общие характеристики 

1. Нажмите Setup > Storage > FTP. Перейдите на вкладку General. 
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2. Укажите IP-адрес и порт для сервера FTP, имя пользователя и пароль, используемые для 

загрузки изображений на сервер FTP, выберите Upload Images, Overwrite Storage и задайте 

значение Overwrite At (порог для перезаписи изображений). Некоторые модели камер 

поддерживают тестирование FTP. После успешной настройки FTP вы можете выполнить 

тестирование FTP. 

3. Задайте путь для сохранения снимков на сервер FTP и формат имени файла. Например, задайте 

путь как № предустановки \\IP-адрес\\дата\\час и установите имя файла как № предустановки-зум 

PTZ-широта PTZ-долгота PTZ.jpg. 

4. Нажмите Save. 

Smart 

Эта функция используется, чтобы сохранять снимки, снятые для интеллектуальных функций, таких 

как распознавание лиц и подсчет людей. 
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1. Нажмите Setup > Storage > FTP. Перейдите на вкладку Smart. 

 

2. Укажите IP-адрес и порт сервера FTP, имя пользователя и пароль, используемые для загрузки 

изображений на сервер FTP. 

3. Задайте путь для сохранения снимков на сервер FTP и формат имени файла. Например, задайте 

путь как № предустановки\\IP-адрес\\дата и задайте имя файла как № предустановки-широта 

PTZ-долгота PTZ-зум PTZ.jpg. 

4. Нажмите Save. 

Электронная почта 

После настройки электронной почты на указанный вами адрес будут отправляться предупреждения 

при срабатывании сигнализации. 
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1. Нажмите Setup > Network > E-mail. 

 

2. Задайте соответствующие параметры для отправителя и получателя. Некоторые модели камеры 

поддерживают тестирование электронной почты. Вы можете проверить электронную почту после 

введения адреса получателя. В следующей таблице описаны некоторые из главных параметров. 

Параметр Описание 

TLS/SSL 

При включении этой функции электронные письма будут шифроваться по протоколу 
TLS (безопасность транспортного уровня) или SSL (протокол защищенных сокетов), 
чтобы обеспечить конфиденциальность. 

Сначала система попытается выполнить отправку по протоколу SSL. Если сервер SMTP 
поддерживает SSL, электронное письмо будет отправлено по SSL, в противном случае 
будет использоваться протокол STARTTLS. 

Attach Image 
При включении этой функции к электронному письму прилагается 3 снимка в соответствии 
с периодом съемки. 

3. Нажмите Save. 

Переключение портов  

1. Нажмите Setup > Network > Port. Перейдите на вкладку Port Mapping. 
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2. Активируйте Port Mapping и выберите тип отображения. Если выбрана опия Manual, тогда 

должны быть заданы внешние порты (внешний IP-адрес получается камерой автоматически). 

Если выбранный порт занят, статус (Status) будет отображаться как неактивный. 

3. Нажмите Save. 

DNS 

1. Нажмите Setup > Network > DNS. 

 

2. Задайте адрес сервера DNS. 

3. Нажмите Save. 

DDNS  

 
ПРИМЕЧАНИЕ! 

Данная функция не поддерживается некоторыми моделями. Для получения подробных данных см. 
фактическую модель. 

 

1. Нажмите Setup > Network > DDNS. 

 

2. Активируйте службу DDNS Service. 

3. Выберите тип DDNS: DynDNS, NO-IP или EZDDNS. 

4. Задайте другие параметры, включая адрес сервера, доменное имя, имя пользователя и пароль. 

5. Нажмите Save. 

EZCloud 

 
ПРИМЕЧАНИЕ! 

 Данная функция не поддерживается некоторыми моделями. 

 На некоторых устройствах эта функция отображается как P2P. 

 

  

https://tm.by 
Интернет-магазин



15 

1. Нажмите Setup > Network > EZCloud. 

 

2. Для активации облачной службы выберите On. 

3. Нажмите Save. 

802.1x 

802.1x обеспечивает аутентификацию устройств (например, камер), пытающихся подключиться к 

сети. Только прошедшие аутентификацию устройства могут подключиться к сети. Это повышает 

уровень безопасности. 

1. Нажмите Setup > Network > 802.1x. 

 

2. Выберите On, а затем выполните другие настройки. 

3. Нажмите Save. 

Настройка изображения 

Настройка параметров изображений 

 
ПРИМЕЧАНИЕ! 

 Отображаемые параметры изображения и допустимые диапазоны значений зависят от 
модели камеры. Чтобы узнать фактические параметры и диапазоны значений вашей камеры, 
см. веб-интерфейс. Чтобы изменить настройки, вы можете перемещать ползунки или 
вводить значения непосредственно в текстовые окна. 

 Нажатие кнопки Default приведет к сбросу всех настроек изображения к значениям по умолчанию. 

 

Параметры сцены 

Задайте параметры изображения для достижения желаемых эффектов для живого видео в 

различных сценах. 

Нажмите Setup > Image > Image. 
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Страница управления сценой для некоторых моделей показана ниже. Вы можете выбрать желаемую 

сцену в выпадающем списке. 

 

Ниже показана страница управления сценой для некоторых других моделей. Здесь вы можете 

выполнить следующие действия, чтобы сконфигурировать сцену. 

 

1. Нажмите Scenes. 

2. Выберите сцену, а затем задайте параметры переключения сцен. В следующей таблице описаны 

некоторые из главных параметров. 

Столбец Описание 

Current 

Указывает сцену, которая сейчас используется. 

Примечание. 

 Нажмите кнопку выбора, чтобы выбрать сцену и открыть соответствующие 
параметры изображения для нее. 

 Если выбрана опция Enable Auto Switching, камера переключает текущую сцену 
автоматически. 

Scene Name 

Имя текущей сцены. Устройство поддерживает несколько предустановленных 
режимов сцены. Когда вы выбираете сцену, отображаются соответствующие 
параметры изображения. Вы можете скорректировать настройки изображения 
согласно фактическим потребностям. 

 Общий: рекомендуется для наружных сцен. 

 Внутренний: рекомендуется для внутренних сцен. 

 Высокая чувствительность: рекомендуется для среды с недостаточной освещенностью. 

 Компенсация подсветки: может подавлять яркий свет, например, от фар автомобилей 
на дорогах и от прожекторов в парках. Рекомендуется для съемки номерных знаков 
автомобилей. 

 Широкий динамический диапазон (WDR): рекомендуется для сцен с высококонтрастным 
освещением, таких как окно, коридор, парадная дверь или другие сцены, которые ярко 
освещены снаружи, но затемнены внутри. 

 Пользовательский: укажите необходимое имя сцены. 

 Лицо: съемка лиц в движении в сложных сценах. 
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Столбец Описание 

Auto 
Switching 

Указывает, добавить ли сцену к списку автоматического переключения. 

Примечание. 

Если выбран режим Auto Switching, система переходит к сцене автоматически при 
выполнении условия переключения сцены. По умолчанию список автоматического 
переключения включает сцену заводской настройки. 

Setup 

Щелкните , чтобы установить условия для автоматического переключения, включая 
расписание, освещение и текущий угол возвышения (угол между PTZ и 
горизонтальной плоскостью). Это означает, что автоматическое переключение 
запускается только тогда, когда освещение и текущий угол возвышения в заданном 
периоде времени удовлетворяют заданным условиям. Это условие недействительно, 
если начальное и конечное значения установлены на 0. 

 

3. Выберите сцену и затем щелкните , чтобы задать ее как сцену по умолчанию. 

4. Если выбран режим автоматического переключения, система переходит к сцене автоматически, 

если выполняется условие переключения на сцену, отличную от сцены по умолчанию. В 

противном случае камера продолжает использовать сцену по умолчанию. Когда автоматическое 

переключение не активировано, камера работает с текущей сценой. 

 
ПРИМЕЧАНИЕ! 

 Если автоматическое переключение активировано (настройки сцены будут недоступны), 
устройство будет переключаться между заданными сценами. В противном случае устройство 
останется в режиме текущей сцены. Устройство будет использовать сцены по умолчанию, 
если другие сцены не будут активированы. 

 Если будет активировано несколько сцен, отличных от сцен по умолчанию, устройство 
выберет сцену с минимальным номером (от 1 до 5). 

 

Улучшение изображения 

 
ПРИМЕЧАНИЕ! 

Эта функция может изменяться в зависимости от модели. Для получения подробных данных см. 
фактический веб-интерфейс.  

 

1. Нажмите Setup > Image > Image, а затем выберите Image Enhancement. 

 

2. Чтобы изменить настройки, используйте ползунки. Вы также можете ввести значения 

непосредственно. В следующей таблице описаны некоторые из главных параметров. 
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Позиция Описание 

Brightness 

Настройка яркости изображения. 

  

Низкая яркость Высокая яркость 
 

Saturation 

Оттенок цвета. 

  

Низкая 
насыщенность 

Высокая 
насыщенность 

 

Contrast 

Установите степень различия между самым черным и самым белым пикселями. 

  

Низкая 
контрастность 

Высокая 
контрастность 

 

Sharpness 

Контрастность границ объектов на изображении. 

  

Низкая резкость Высокая резкость 
 

2D Noise 
Reduction 

Снижение уровня шума изображений. Эта функция может вызывать размытие 
изображения. 

3D Noise 
Reduction 

Снижение уровня шума изображений. Эта функция может вызывать размытость 
изображения движущегося объекта (или его раздвоение в некоторых случаях). 

Image 
Rotation 

Вращение изображения.  
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Позиция Описание 

  

Обычная запись Перевернуть по вертикали 

  

Перевернуть по горизонтали 180° 

  

Поворот на 90° по часовой 
стрелке 

Поворот на 90° против часовой 
стрелки 

 

 

3. Чтобы восстановить настройки по умолчанию в этой области, нажмите Default. 

Экспозиция 

 
ПРИМЕЧАНИЕ! 

 Эта функция может изменяться в зависимости от модели. Для получения подробных данных 
см. фактический веб-интерфейс. 

 Настройки по умолчанию зависят от сцены. Используйте настройки по умолчанию, если 
изменения не требуются. 
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1. Нажмите Setup > Image > Image, а затем выберите Exposure. 

 
Для некоторых моделей камер страница отображается следующим образом. 

 
2. Измените настройки в соответствии со своими требованиями. В следующей таблице описаны 

некоторые из главных параметров. 

Параметр Описание 

Exposure 
Mode 

Выберите необходимый режим экспозиции, чтобы достигнуть желаемого эффекта. 

 Авто: Камера автоматически регулирует выдержку в соответствии с состоянием 
окружающей среды. 

 Пользовательский: пользователь устанавливает выдержку в соответствии со 
своими требованиями. 

 В помещении, 50 Гц: уменьшение числа полос за счет ограничения частоты 
срабатывания затвора. 

 В помещении, 60 Гц: уменьшение числа полос за счет ограничения частоты 
срабатывания затвора. 

 Ручной: точная настройка качества изображения путем ручной регулировки 
затвора, усиления и диафрагмы. 

 Низкая размытость изображения движущегося объекта: регулировка 
минимального времени срабатывания затвора для снижения размытости 
изображений лиц, заснятых во время движения. 

Shutter (s) 

Для управления светом, поступающим в объектив, используется затвор. Высокая скорость 
затвора подходит для быстрой смены кадров, а низкая скорость — для медленной. 

Примечание. 

 Вы можете установить скорость затвора, когда для параметра Exposure Mode 
установлено значение Manual или Shutter Priority.  

 Если для параметра Slow Shutter установлено значение Off, обратная величина 
скорости затвора должна быть больше частоты кадров. 
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Параметр Описание 

Gain (dB) 

Управляйте сигналами изображения так, чтобы на выходе камеры были стандартные 
видеосигналы, соответствующие уровню освещения. 

Примечание.  

Вы можете настроить этот параметр только тогда, когда для параметра Exposure Mode 
установлено значение Manual или Gain Priority. 

Slow Shutter 

Улучшение яркости изображения в условиях низкой освещенности. 

Примечание.  

Вы можете настроить этот параметр только тогда, когда для параметра Exposure Mode 
не установлено значение Shutter Priority, а функция Image Stabilizer отключена. 

Slowest 
Shutter 

Установите самую медленную скорость затвора, которую камера может использовать 
во время экспозиции. 

Примечание.  

Вы можете настроить этот параметр только тогда, когда для параметра Slow Shutter 
установлено значение On. 

Compensation 

Задайте значение компенсации, чтобы достигнуть желаемых эффектов. 

Примечание.  

Вы можете настроить этот параметр только тогда, когда для параметра Exposure Mode 
не установлено значение Manual. 

Metering 
Control 

Выберите способ измерения интенсивности освещения камерой. 

 Центровзвешенный средний замер: интенсивность освещения измеряется в 
основном в центральной части изображений. 

 Оценочный замер: интенсивность освещения измеряется в заданной области 
изображений. 

 Компенсация подсветки: яркость передержанных областей изображений 
игнорируется. Однако выбор этой опции уменьшит общую яркость изображения. 

 Замер по лицу: коррекция качества изображения при слабом освещении и 
контроле яркости лица в сцене Face (Лицо). 

Примечание.  

Вы можете настроить этот параметр только тогда, когда для параметра Exposure Mode 
не установлено значение Manual. 

Day/Night 
Mode 

 Авто: камера выводит оптимальное изображение в соответствии с уровнем 
освещения. В этом режиме камера может автоматически переключаться между 
режимами дня и ночи. 

 Ночь: Камера обеспечивает высококачественное черно-белое изображение при 
существующем освещении 

 День: Камера обеспечивает высококачественное цветное изображение при 
существующем освещении. 

Day/Night 
Sensitivity 

Порог освещенности при переключении между режимами дня и ночи. Высокая 
чувствительность означает, что камера более чувствительна к изменению света и 
легче переключается между режимами дня и ночи. 

Примечание. 

Вы можете настроить этот параметр только тогда, когда для параметра Day/Night 
Mode установлено значение Automatic. 

Day/Night 
Switching(s) 

Установите задержку перед переключением между режимами дня и ночи после 
выполнения условия переключения. 

Примечание. 

Вы можете настроить этот параметр только тогда, когда для параметра Day/Night 
Mode установлено значение Automatic. 
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Параметр Описание 

WDR 

Включите функцию WDR (широкий динамический диапазон), чтобы различать яркие и 
темные области в одном и том же изображении. 

Примечание.  

Вы можете настроить этот параметр только тогда, когда для параметра Exposure Mode 
не заданы значения Customize и Manual, а функция Image Stabilizer отключена. 

WDR Level 

После включения функции WDR вы можете улучшить изображение, корректируя 
уровень динамического диапазона. 

Примечание.  

В случае высокой контрастности между яркими и темными областями сцены используйте 
уровень 7 или выше. В случае низкой контрастности рекомендуется отключить WDR или 
использовать уровни 1-6. 

Suppress WDR 
Stripes 

При включении этой функции камера может автоматически корректировать частоту 
медленного затвора в соответствии с частотой света, чтобы минимизировать полосы, 
которые могут появляться на изображении. 

 

3. Чтобы восстановить настройки по умолчанию, нажмите Default. 

Умная подсветка 

 
ПРИМЕЧАНИЕ! 

Эта функция может изменяться в зависимости от модели. Для получения подробных данных см. фактический 
веб-интерфейс.  

 

1. Нажмите Setup > Image > Image, а затем выберите Smart Illumination. 

 

2. Выберите соответствующий режим управления ИК-подсветкой и задайте параметры. В 

следующей таблице описаны некоторые из главных параметров. 

Параметр  Описание  

Lighting Type 

 Инфракрасный: камера использует инфракрасную подсветку. 

 Белый свет: камера использует подсветку белым светом. 

Примечание. 

Когда для параметра Control Mode установлено значение Manual, для камеры можно 
установить уровни освещения от 0 до 1000. 

Control Mode 

 Глобальный режим: камера регулирует уровень ИК-подсветки и выдержку, чтобы 
обеспечить сбалансированные эффекты передачи изображений. При выборе этой 
опции некоторые области изображения могут быть передержаны. Рекомендуется 
использовать эту опцию, если вашей первоочередной задачей является 
обеспечение контролируемого диапазона яркости изображений. 

 Ограничение передержки: Камера регулирует уровень ИК-подсветки и выдержку, 
чтобы не допустить передержки некоторых областей изображений. При выборе 
этой опции некоторые области изображения могут оказаться черными. 
Рекомендуется использовать эту опцию, если вашей первоочередной задачей 
является обеспечение четкости в центральной части изображения и контроль 
передержки. 
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 Дорога: эта опия обеспечивает яркое освещение в полной зоне обзора. Она 
рекомендуется для контроля обширных сцен, например, дороги. 

 Парк: эта опция обеспечивает равномерное освещение. Она рекомендуется для 
контроля небольших сцен со многими препятствиями, например, технопарков. 

 Ручной: эта опция позволяет вручную регулировать интенсивность ИК-подсветки. 

 Внутри: эту опцию рекомендуется использовать во внутренних сценах. 

Illumination 
Level 

Установите уровень яркости ИК-подсветки. Чем выше значение, тем выше интенсивность. 
Значение 0 означает, что ИК-подсветка отключена. 

 Уровень ближнего освещения: рекомендуется задать этот параметр для 
широкоугольной сцены. 

 Уровень среднего освещения: рекомендуется задать этот параметр, если сцена 
требует промежуточного фокусного расстояния. 

 Уровень дальнего освещения: рекомендуется задать этот параметр, если для 
обзора сцены требуется телеобъектив. 

Примечание. 

Вы можете настроить этот параметр только тогда, когда для параметра Control Mode 
установлено значение Manual. 

 

3. Чтобы восстановить настройки по умолчанию, нажмите Default. 

Фокус  

 
ПРИМЕЧАНИЕ! 

Эта функция может изменяться в зависимости от модели. Для получения подробных данных см. 
фактическую модель.  

 

1. Нажмите Setup > Image > Image, а затем выберите Focus. 

 

2. Выберите необходимый режим фокусировки. 

Параметр Описание 

Focus Mode 

 Автофокус: камера фокусируется автоматически в соответствии с текущей 
освещенностью. 

 Ручной фокус: ручная фокусировка камеры. 

 Фокус в одно нажатие: камера фокусируется один раз при вращении, изменении 
масштаба изображения или включении предустановки. 

 Фокусировка одним щелчком (ИК): при слабом освещении, например, в вечерние 
часы или в темном доме, этот способ фокусировки обеспечивает лучшие 
результаты с включенной ИК-подсветкой. 

Scene 

 Обычная запись: используемый для общих сцен, таких как дороги и технопарки. 

 Большое расстояние: используемый для дальнего мониторинга на дороге. 
Например, когда камера устанавливается на высоте более 30 м для контроля 
отдаленного дорожного перекрестка. 

 

3. Чтобы восстановить настройки по умолчанию, нажмите Default. 
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Баланс белого 

Баланс белого является процессом коррекции неестественных цветовых оттенков с различными 

цветовыми температурами, чтобы создать изображение, которое наилучшим образом воспринимается 

человеческим глазам. 

 
ПРИМЕЧАНИЕ! 

Эта функция может изменяться в зависимости от модели. Для получения подробных данных см. 
фактический веб-интерфейс. 

 

1. Нажмите Setup > Image > Image, а затем выберите White Balance. 

 

2. Выберите необходимый режим баланса белого. В следующей таблице описаны некоторые из 

главных параметров. 

Параметр Описание 

White Balance 

Настройка красного или синего смещения в изображении: 

 Авто/Авто2: камера автоматически корректирует красное и синее смещение в 
соответствии с уровнем освещения (имеется тенденция смещения в синюю часть 
спектра). Если изображения остается все еще противоестественно красными или 
синими в режиме Auto, попробуйте режим Auto2. 

 Точная настройка: позволяет корректировать красное и синее смещение вручную. 

 Снаружи: опия для открытой среды с относительно широким диапазоном цветовых 
температур. 

 Заблокировано: блокировка текущей цветовой температуры без возможности 
изменения. 

 Натриевая лампа: камера автоматически корректирует красное и синее смещение 
в соответствии с уровнем освещения (имеется тенденция смещения в красную 
часть спектра). 

Red Offset 

Ручная коррекция красного смещения. 

Примечание.  

Вы можете настроить этот параметр только тогда, когда для параметра White Balance 
установлено значение Fine Tune. 

Blue Offset 

Ручная коррекция синего смещения. 

Примечание. 

Вы можете настроить этот параметр только тогда, когда для параметра White Balance 
установлено значение Fine Tune. 

 

3. Чтобы восстановить настройки по умолчанию, нажмите Default. 

Дополнительно 

Используйте функцию «Антитуман» для корректировки четкости изображений, полученных в тумане 

или атмосферной дымке. 
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1. Нажмите Setup > Image > Image, а затем выберите Advanced. 

 
 

 
ПРИМЕЧАНИЕ! 

 Вы можете настроить этот параметр только тогда, когда функция WDR отключена. 

 Некоторые модели камер поддерживают функцию оптического антитумана. Когда для 
параметра Defog установлено значение On, уровни интенсивности 6-9 соответствуют 
оптическому антитуману. Когда интенсивность антитумана установлена на уровень 5 или 6, 
изображение переключается с цветного на черно-белое. Когда для параметра Defog 
установлено значение Auto, а интенсивность антитумана находится между уровнями 6–9, 
изображение не становится автоматически черно-белым в условиях легкого тумана. Камера 
автоматически переключается в режим оптического антитумана только в условиях густого 
тумана. 

 

2. Включите функцию антитумана, а затем выберите уровень для сцены. Уровень 9 соответствует 

максимальному эффекту антитумана, а уровень 1 – минимальному. 

  

Функция антитумана выключена Функция антитумана включена 

 

3. Чтобы восстановить настройки по умолчанию, нажмите Default. 

Тип освещения 

 
ПРИМЕЧАНИЕ! 

Эта функция может изменяться в зависимости от модели. Для получения подробных данных см. фактическую 
модель.  

 

1. Нажмите Setup > Image > Image, а затем выберите Smart Illumination 

 

2. Выберите опцию в выпадающем списке Lighting Type. 

3. Чтобы восстановить настройки по умолчанию, нажмите Default. 
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Выбор режима диаграммы и объектива 

 
ПРИМЕЧАНИЕ! 

 Эта функция поддерживается только некоторыми типами корпусных IP-камер. Для получения 
подробных данных см. фактическую модель. 

 Используйте объектив с режимом управления P-диафрагмой и подключите кабель 
управления диафрагмой к порту Z/F камеры. 

 Диафрагму можно настроить только тогда, когда для параметра Lens Mode установлено 
значение P-IRIS. 

 

1. Нажмите Setup > Image > Image, а затем выберите Advanced. 

 

2. Измените настройки в соответствии со своими требованиями. В следующей таблице описаны 

некоторые из главных параметров. 

Параметр Описание 

Lens Mode 
 Z/F: изменение фокуса и зума. 

 P-Iris: изменение значения диафрагмы. 

Aperture 
Control 

Настройте диафрагму автоматически или вручную. 

Примечание.  

Вы можете настроить этот параметр только тогда, когда для параметра Lens Mode 
установлено значение P-Iris. 

F-Number Изменение диафрагмы вручную. 

 

3. Чтобы восстановить настройки по умолчанию, нажмите Default. 

Настройки экранного интерфейса 

Экранный интерфейс (OSD) включает текст, видеоизображения и элементы, которые может выбрать 

пользователь, такие как время и т. д. 

 
ПРИМЕЧАНИЕ! 

Эта функция может изменяться в зависимости от модели. Для получения подробных данных см. 
фактический веб-интерфейс. 
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1. Нажмите Setup > Image > OSD. 

 

Ниже показан интерфейс, отображаемый на некоторых моделях. 

  

2. Выберите контент экранного интерфейса и его местоположение на экране. 

 Местоположение: Щелкните требуемое поле в области Live View. После изменения формы курсора 

нажмите и удерживайте левую кнопку мыши, чтобы перетащить поле в нужное положение. Для 

точной установки местоположения используйте координаты X и Y в области Overlay Area. 

 Overlay OSD Content: Выпадающий список содержит следующие пункты: Time, Preset и Serial Info. 

Вы можете также выбрать Custom и ввести свой контент. 

 После конфигурации контента экранного интерфейса и его местоположения в колонке Status 

появляется символ . Это означает, что экранный интерфейс успешно настроен. Вы можете 

создать несколько строк контента для каждой области и использовать клавиши  и  для 

выбора последовательности отображения. 

3. После выполнения настройки появится сообщение об успешном завершении этой операции. 

Вы можете щелкнуть правой кнопкой мыши в окне предварительного просмотра и выбрать 

просмотр в полноэкранном или другом формате. Вы также можете дважды щелкнуть в окне 

предварительного просмотра, чтобы войти в полноэкранный формат или выйти из него. 
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Чтобы отменить экранный интерфейс для области, удалите его контент в колонке Overlay OSD 

Content или выберите None в столбце Position. 

Ниже приведен пример наложения времени. 

 

Режим маскирования 

В некоторых случаях может потребоваться задать область маски на изображении с камеры для 

обеспечения конфиденциальности, например, в области клавиатуры банкомата. При изменении 

направления обзора или масштаба изображения маска конфиденциальности должна смещаться 

соответствующим образом для постоянной защиты заданной области. 

 
ПРИМЕЧАНИЕ! 

Эта функция может изменяться в зависимости от модели. Для получения подробных данных см. 
фактический веб-интерфейс.  

 

1. Нажмите Setup > Image > Privacy Mask. 
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В некоторых моделях камер отображается следующая страница: 

 

2. Чтобы добавить маску конфиденциальности, нажмите . Чтобы удалить маску, нажмите . 

 Маскировка позиции: щелкните в поле, где отображается маска (Mask), чтобы активировать ее. 

После изменения формы курсора перетащите поле в нужное положение. 

 Маскировка области: используя мышь, нарисуйте поле в области, которую требуется замаскировать. 

Если маска конфиденциальности настроена, требуемая область будет заблокирована. Следующие 

иллюстрации представлены в качестве примера. 

 

Настройка аудио и видео 

Конфигурация видео 

Вы можете задать параметры видео, которые поддерживает ваша камера и просматривать текущее 

состояние выхода BNC. При необходимости вы можете также включить дополнительный поток и 

третий поток, если эти функции поддерживаются камерой. 

 

ПРИМЕЧАНИЕ! 

 Эта функция может изменяться в зависимости от модели. Не все модели камер поддерживают 
третий поток. Чтобы определить, поддерживает ли ваша камера эту функцию, см. веб-интерфейс. 

 После включения дополнительного или третьего потока, измените параметры соответствующим 
образом. Параметры для дополнительного и третьего потока имеют те же значения, что и для 
основного потока. 
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1. Нажмите Setup > Video & Audio > Video. 

 

2. Измените настройки в соответствии со своими требованиями. В следующей таблице описаны 

некоторые из главных параметров. 

Параметр Описание 

Video 
Compression 

Три опции: H.265, H.264 и MJPEG. 

Примечание. 

 Качество изображения не может быть настроено, когда для сжатия видео 
установлены опции H.265 или H.264. При выборе опции MJPEG доступны только 
три частоты кадров: 1, 3 и 5; при этом значения скорости потока, интервала 
I-кадров, плавности и U-кода не могут быть заданы. 

 При переключении между H.264 и H.265 для скорости потока устанавливается 
значение по умолчанию. Скорость потока по умолчанию для H.265 в два раза 
меньше, чем для H.264. 

Frame Rate 

Частота кадров для кодирования изображений. ед. изм.: к/сек. (кадр в секунду). 

Примечание. 

Для обеспечения высокого качества изображения обратите внимание на то, что 
частота кадров не должна быть больше, чем обратная величина скорости затвора. 

Bitrate Type 

 CBR: постоянная скорость потока. Это означает, что камера передает данные с 
постоянной скоростью. 

 VBR: переменная скорость потока. Это означает, что камера динамически 
регулирует скорость потока в соответствии с качеством изображения. 

Image Quality 

Когда для параметра Encoding Mode установлено значение VBR, вы можете 
регулировать качество изображения, передвигая ползунок. Перемещение ползунка 
в сторону Bit Rate уменьшает скорость потока, но может негативно повлиять на 
качество изображения. Перемещение ползунка в сторону Quality увеличивает 
скорость потока и повышает качество изображения. 

I Frame Interval 
Интервал кодирования I-кадров. Как правило, более короткий интервал I-кадров 
обеспечивает лучшее качество изображения, но требует большей пропускной 
способности. 
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Параметр Описание 

GOP 
Группа изображений с кодированием MPEG. Этот параметр определяет порядок 
следования интра-кадров (кадров с внутренним кодированием, I-кадров) и 
интер-кадров. 

SVC 
Функция SVC (масштабируемое кодирование видео) помогает снизить объем 
сохраняемых данных, не снижая качество воспроизведения. 

U-Code 

 Стандартный режим: фактическая скорость потока составляет 3/4 от заданной 
скорости. 

 Расширенный режим: фактическая скорость потока составляет 1/2 от заданной 
скорости. 

Примечание. 

 Когда U-код активирован, сжатие видео поддерживается только в форматах H.264 
и H.265. Формат MJPEG не поддерживается. 

 Когда U-код активирован, режим съемки не поддерживает частоту кадров выше 
30 к/сек. 

Smoothing 

Установите степень плавности. При выборе Clear функция плавности Smoothing 
отключается. Перемещение ползунка в сторону Smooth повышает уровень 
плавности, но может негативно повлиять на качество изображения. 

Примечание.  

В ненадежной сетевой среде вы можете включить функцию плавности для 
получения более равномерного видео. 

BNC Output Выход BNC поддерживает форматы NTSC и PAL. 

 

3. Нажмите Save. 

Настройка аудиоканала 

Настройка аудиоканала подразумевает задание параметров кодирования звука для камеры. 

 

ПРИМЕЧАНИЕ! 

Данная функция не поддерживается некоторыми моделями. Для получения подробных данных см. 
фактическую модель. 

 

1. Нажмите Setup > Video & Audio > Audio. 

 

2. Измените настройки в соответствии со своими требованиями. В следующей таблице описаны 

некоторые из главных параметров. 
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Параметр Описание 

Audio Input 

Если выбрано значение Off, аудиоданные не будут кодироваться. 

Примечание.  

Если вам не нужно звуковое сопровождение, рекомендуется выбрать Off. Это может в 
некоторой степени повысить производительность устройства. 

Access Mode 

В настоящее время доступны только две опции: Line/Mic (линия/микрофон). 

Примечание.  

Эта функция недоступна на устройствах с двумя аудиовыходами. 

Audio 
Compression 

Три опции: G.711U, G.711A и ACC-LC.  

G.711U и G.711A поддерживают только частоту дискретизации 8 кГц, а ACC-LC 
поддерживает частоты 8, 16 и 48 кГц. 

Input Gain 
Усиление аудиосигнала для дискретизации. Чем больше усиление, тем большее 
увеличение. 

Noise 
Suppression 

Используется для снижения уровня шума на изображениях. Чтобы включить 
шумоподавление, выберите On. 

Channel 

Канал аудиовыхода. Для включения аудиовыхода выберите Enable. 

Примечание.  

Не все модели камер поддерживают два канала. 

 

3. Нажмите Save. 

Создание снимков. 

1. Нажмите Setup > Video & Audio > Snapshot. 

 

2. Выберите On, а затем выберите разрешение, качество изображения и расписание в соответствии со 

своими требованиями. 

3. Нажмите Save. 

ROI 

Когда включена функция области интереса (ROI), а скорость потока ограничена, система сначала 

обеспечивает хорошее качество изображения для ROI. 

 

ПРИМЕЧАНИЕ! 

Данная функция не поддерживается некоторыми моделями. Для получения подробных данных см. 
фактическую модель. 
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1. Нажмите Setup > Video & Audio > ROI. 

 

2. Нажмите , а затем используйте перетаскивание мышью для покрытия заданной части 

изображений. Для удаления выберите область, а затем нажмите . 

Настройка потока медиаданных 

Поток медиаданных 

Вы можете отображать установленные потоки медиаданных с камеры. Вы можете также настроить 

камеру, таким образом, чтобы она передавала кодовые потоки по протоколу UDP или TCP на 

указанный IP-адрес и номер порта. Настройки могут быть сохранены. Они вступят в силу после 

перезапуска камеры. 

 

ПРИМЕЧАНИЕ! 

 Данная функция не поддерживается некоторыми моделями. Для получения подробных 
данных см. фактическую модель. 

 Выберите транспортный протокол на основе ваших фактических потребностей и 
производительности сети. Проще говоря, TCP обеспечивает лучшее качество изображения, 
чем UDP, но повышает время ожидания. 

 

1. Нажмите Setup > Video & Audio > Media Stream. 
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2. Нажмите , выберите тип потока, а затем задайте IP-адрес и номер порта одноадресной или 

многоадресной группы для декодирующего устройства, которое получает аудио- и видеопотоки 

от камеры. 

Если вы хотите, чтобы устройство выбрало поток медиаданных, который был задан до 

автоматической настройки после перезагрузки устройства, выберите для параметра Persistent 

значение Yes. 

3. Для удаления потока нажмите . 

4. Нажмите Submit для завершения операций. 

Адрес RTSP Multicast  

После задания адреса RTSP Multicast проигрыватель стороннего производителя может затребовать 

многоадресный поток RTSP с камеры по протоколу RTP. 

1. Нажмите Setup > Video & Audio > Media Stream > RTSP Multicast Address. 
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Для некоторых моделей камер страница отображается следующим образом. 

 

2. Задайте адрес многоадресной передачи (от 224.0.0.0 до 239.255.255.255) и номер порта  

(от 0 до 65 535). 

3. Нажмите Save. 

Настройка интеллектуальной сигнализации 

Вы можете сконфигурировать интеллектуальный мониторинг с подсчетом числа людей и 

отслеживанием перемещающихся объектов. Интеллектуальный мониторинг включает подсчет 

посетителей, обнаружение вторжений и автоматическое отслеживание объектов. 

Поддерживаемые функции зависят от модели камеры. 
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Умные настройки 

Нажмите Setup > Intelligent > Smart Settings. 

 

Для некоторых моделей камер страница отображается следующим образом. 
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Обнаружение пересечения линии 

Функция обнаружения пересечения линии обнаруживает объекты, которые пересекают виртуальную 

линию в режиме живого видео. При обнаружении такого события срабатывает сигнализация. 

1. Нажмите Setup > Intelligent > Smart Settings. Выберите Cross Line и нажмите  . 

 

 

2. Выберите Cross Line Detection. 

3. В разделе Detection Rule щелкните  для добавления новой области обнаружения. Для 

удаления области обнаружения нажмите . 

4. В маленьком окне предварительного просмотра протяните линию к намеченной позиции и 

задайте диапазон обнаружения. 

5. Задайте направление и чувствительность, при которой камера должна сигнализировать о 

пересечении линии. 

6. Задайте действия по сигналу тревоги и расписание постановки на охрану в соответствии со 

своими требованиями. Для получения подробных сведений см. описания действий по сигналу 

тревоги в Настройка параметров сигнализации детекции движения. 

7. Нажмите Save. 
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Обнаружение вторжения 

Функция обнаружения вторжения обнаруживает объекты, которые проникают в заданную область в 

режиме живого видео. При обнаружении такого события срабатывает сигнализация. 

1. Нажмите Setup > Intelligent > Smart Settings. Выберите Intrusion и нажмите . 

 

2. Выберите Intrusion Detection. 

3. В разделе Detection Rule щелкните  для добавления новой области обнаружения. Для 

удаления области обнаружения нажмите . 

4. Установите требуемые позиции и диапазон путем перетаскивания границ поля. 

5. Установите порог времени, чувствительность и процентный коэффициент, при которых камера 

должна сигнализировать об обнаружении вторжения. 

 Time Threshold: Минимальный отрезок времени, в течении которого нарушитель может 

находиться в области обнаружения перед срабатыванием сигнализации. 

 Sensitivity: Чувствительность обнаружения. Чем больше значение, тем больше чувствительность 

обнаружения. 

 Percentage: Минимальное отношение размера нарушителя к размеру заданной области 

обнаружения, при котором срабатывает сигнализация. 

6. Задайте действия по сигналу тревоги и расписание постановки на охрану в соответствии со 

своими требованиями. Для получения подробных сведений см. описания действий по сигналу 

тревоги в Настройка параметров сигнализации детекции движения. 

7. Нажмите Save. 
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Обнаружение лиц 

Функция обнаружения лиц распознает лица людей в режиме живого видео. 

1. Нажмите Setup > Intelligent > Smart Settings. Выберите Face и нажмите . 

 

2. Установите требуемые позиции и диапазон путем перетаскивания границ. 

3. Установите параметры обнаружения согласно фактическим потребностям. 

4. Задайте действия по сигналу тревоги и расписание постановки на охрану в соответствии со 

своими требованиями. Для получения подробных сведений см. описания действий по сигналу 

тревоги в Настройка параметров сигнализации детекции движения. 

5. Нажмите Save. 

6. Нажмите Start Intelligent Analysis. 

Подсчет людей 

 

ПРИМЕЧАНИЕ! 

 Не все модели камер поддерживают эту функцию. 

 Поддерживаемые функции срабатывания сигнализации и расписания постановки на охрану 
зависят от конкретной модели камеры. Для получения подробных данных см. фактический 
веб-интерфейс. 
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1. Нажмите Setup > Intelligent > Smart Settings. Выберите People Counting и нажмите . 

 
2. Выберите Enable Passenger Flow Detection. Выберите способ обнаружения, установите интервал 

отправки сигнала и чувствительность. 

3. Нажмите Draw Detection Area, а затем нарисуйте область обнаружения (например, квадрат) в 

окне предварительного просмотра слева. 

4. Нажмите Draw Entrance Direction, а затем обозначьте направление в окне предварительного 

просмотра слева. Направление обычно бывает вертикальным или наклонным. 

5. В разделе Filter by Object Size установите значения для Max. Size и Min. Size. Подсчитываться 

будут только те объекты, которые попадают в заданный диапазон размеров, все другие будут 

отфильтрованы. 

6. Задайте действия по сигналу тревоги и расписание постановки на охрану в соответствии со 

своими требованиями. Для получения подробных сведений см. описания действий по сигналу 

тревоги в Настройка параметров сигнализации детекции движения. 

7. Для сброса результатов подсчета нажмите Clear Counting Result. 

8. Нажмите Save. 

Автоматическое слежение 

Камера автоматически отслеживает объект, который соответствует правилу. 

 

ПРИМЕЧАНИЕ! 

 Не все модели камер поддерживают эту функцию. 

 Поддерживаемые функции срабатывания сигнализации и расписания постановки на охрану 
зависят от конкретной модели камеры. Для получения подробных данных см. фактический 
веб-интерфейс. 
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1. Нажмите Setup > Intelligent > Smart Settings. Выберите Auto Tracking и нажмите . 

 

2. Установите таймаут отслеживания (в секундах) и коэффициент зума. 

3. Нажмите Save. 

Обнаружение расфокусировки 

 

ПРИМЕЧАНИЕ! 

 Не все модели камер поддерживают эту функцию. 

 Поддерживаемые функции срабатывания сигнализации и расписания постановки на охрану 
зависят от конкретной модели камеры. Для получения подробных данных см. фактический 
веб-интерфейс. 

 

Используйте функцию обнаружения расфокусировки, чтобы получать предупреждения при обнаружении 

расфокусировки камеры. 

1. Нажмите Setup > Intelligent > Smart Settings. Выберите Defocus и нажмите . 

 

2. Выберите Defocus Detection. 

3. Задайте чувствительность обнаружения и действия по сигналу тревоги в соответствии со своими 

требованиями. Для получения подробных сведений см. описания действий по сигналу тревоги в 

Настройка параметров сигнализации детекции движения. 

4. Нажмите Save. 
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Обнаружение смены сцены 

 

ПРИМЕЧАНИЕ! 

 Не все модели камер поддерживают эту функцию. 

 Поддерживаемые функции срабатывания сигнализации и расписания постановки на охрану 
зависят от конкретной модели камеры. Для получения подробных данных см. фактический 
веб-интерфейс. 

 

Используйте функцию обнаружения смены сцены, чтобы распознавать изменения среды контроля, 

вызванные внешними факторами, такими как намеренный поворот камеры, и получать предупреждений 

о таких событиях. 

1. Нажмите Setup > Intelligent > Smart Settings. Выберите Scene Change и нажмите . 

 

2. Выберите Scene Change Detection. 

3. Задайте чувствительность обнаружения. Задайте действия по сигналу тревоги и расписание 

постановки на охрану в соответствии со своими требованиями. Для получения подробных 

сведений см. описания действий по сигналу тревоги в Настройка параметров сигнализации 

детекции движения. 

4. Нажмите Save. 

Дополнительные настройки 

Дополнительные настройки включают опции четкости снимков и режимы обнаружения для 

интеллектуальных функций. 
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Параметры фото 

Задайте четкость снимков. 

1. Нажмите Setup > Intelligent > Advanced Settings. Откройте вкладку Photo parameters. 

 

2. Задайте четкость оригинального изображения и его миниатюры. 

3. Нажмите Save. 

 

ПРИМЕЧАНИЕ! 

Перед настройкой параметров фото отключите функцию распознавания лиц. 

 

Параметры обнаружения 

 

ПРИМЕЧАНИЕ! 

 Не все модели камер поддерживают дополнительные настройки. Для получения подробных 
данных см. фактический веб-интерфейс. 

 Режим обнаружения по умолчанию: Normal Mode. Выполните настройку в соответствии со 
своими требованиями. 

 

1. Нажмите Setup > Intelligent > Advanced Settings. Откройте вкладку Detection parameters. 

 

2. Выберите режим обнаружения. Выберите Filter Repeated Motion Mode для предотвращения 

отправки повторных сигналов тревоги при повторном обнаружении движения в зоне контроля. 

3. Нажмите Save. 

Настройка общих сигналов тревоги 

Вы можете запланировать отправку отчетов сигнализации и задать действия, которые могут быть 

запущены другими устройствами, чтобы сигналы тревоги и ответные действия могли быть обработаны 

вовремя. 

Отчеты сигнализации могут быть запланированы для детекции движения, тревожного входа и 

выхода, обнаружения взлома и тревоги по звуку. Поддерживаемые типы сигнализации зависят от 

конкретной модели камеры. Чтобы узнать, какие типы сигнализации поддерживаются вашей 

камерой, см. веб-интерфейс. 

Настройка параметров сигнализации детекции движения 

Функция детекции движения позволяет обнаружить движение объекта в заданной прямоугольной 

области в течение определенного периода времени. Генерация сигнала тревоги камерой при 

обнаружении движения зависит от следующих параметров: область обнаружения, чувствительность 

обнаружения, размер объекта и история событий. Эти параметры должны быть заданы 

пользователем. 

https://tm.by 
Интернет-магазин



44 

 

ПРИМЕЧАНИЕ! 

 Данная функция не поддерживается некоторыми моделями. Для получения подробных данных см. 
фактическую модель. 

 Действия по сигналу тревоги зависят от конкретной модели. Для получения подробных данных см. 
фактический веб-интерфейс. 

 

Область обнаружения 

1. Нажмите Setup > Events > Common Alarm > Motion Detection. Установите для параметра 

Detection Mode значение Area. 

 

2. В разделе Detection Area щелкните  для добавления новой области обнаружения. Для 

удаления области обнаружения нажмите . 

3. Задайте область обнаружения, используя функцию перетаскивания мыши. 

4. Генерация сигнала тревоги камерой при обнаружении движения также зависит от следующих 

параметров: чувствительность обнаружения, размер объекта и история событий. Эти параметры 

должны быть заданы пользователем. 

 Перемещение ползунка вправо повышает чувствительность обнаружения. Когда размер 

движущегося объекта в области обнаружения превышает заданный размер, а продолжительность 

движения при этом превышает заданную продолжительность, камера отправляет сигнал тревоги. 

 Размер объекта определяет минимальное отношение размера нарушителя к размеру всей 

области обнаружения, при котором срабатывает сигнализация. Таким образом, для 

обнаружения движения малых объектов вы должны нарисовать соответствующее малое поле 

(область обнаружения) в фактической области движения. 

 Результаты детекции движения отображаются в режиме реального времени. Красные линии 

представляют собой сигналы тревоги, активированные при обнаружении движения. Чем длиннее 

линия, тем больше продолжительность движения. Чем толще линия, тем больше частота движения. 
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5. Настройка параметров сигнализации. 

 Подавление сигналов тревоги: после первого срабатывания сигнализации те же самые сигналы 

тревоги не будут отправляться в течение установленного времени. 

 Сброс сигналов тревоги: если после первого срабатывания сигнализации, 

a. тот же самый сигнал тревоги не будет активирован в течение заданного времени, этот 

сигнал тревоги будет сброшен. После сброса отправка сигнала тревоги этого типа снова 

станет возможной. 

b. Если тот же самый сигнал тревоги будет активирован в течение заданного времени, этот 

сигнал тревоги не будет сброшен, пока не истечет время подавления этого сигнала. После 

этого тот же самый сигнал тревоги может быть отправлен снова. 

6. Укажите действия, которые запускаются по сигналу детекции движения, и составьте план. 

В следующей таблице приведены описания основных действий по сигналу тревоги и инструкции по 

составлению плана. 

Позиция Описание 

Alarm 
Output 1 

Установите флажок. Эта настройка связывает интерфейс тревожного выхода с сигнализацией 
детекции движения. 

Примечание.  

При срабатывании сигнализации камера отправляет сигнал на тревожный выход, чтобы 
запустить действия с помощью устройств сторонних производителей. 

Goto 
Preset 

Установите флажок и задайте предустановку, связанную с сигнализацией детекции 
движения. 

Примечание. 

 Удостоверьтесь, что предустановки заданы. Иначе вы не сможете настроить этот 
параметр. Для получения дополнительной информации о задании предустановок см. 
Задание предустановок. 

 При срабатывании сигнализации PTZ-камера автоматически использует предустановку 
для записи видео в соответствующей сцене. 

Upload to 
FTP 

При выборе опции Upload to FTP камера будет автоматически загружать снимки на 
указанный сервер FTP в случае срабатывания сигнализации. 

Примечание. 

Перед использованием этой функции удостоверьтесь, что настройка параметров FTP и 
Создание снимков. выполнена. 

Recording 

При выборе функции Recording камера будет автоматически записывать видео в случае 
срабатывания сигнализации. 

Примечание. 

Сначала настройте параметр Post-Record(s) на странице Storage. Параметр Post-Record(s) 
определяет продолжительность записи после окончания тревоги. 

Alarm the 
Center 

При выборе функции Alarm the Center камера будет посылать информацию о сигналах 
тревоги на центральный сервер в случае срабатывания сигнализации. 

Примечание. 

Сначала завершите настройку на странице Server. 

Trigger 
Tracking 

При выборе функции Trigger Tracking камера будет автоматически запускать слежение за 
объектом в случае срабатывания сигнализации. 

Примечание. 

Не все модели камер поддерживают эту функцию. 

Сначала активируйте функцию автоматического слежения на странице Smart Settings. 
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Trigger 
E-mail 

При выборе функции Trigger E-mail камера будет автоматически отправлять снимки на 
заданный адрес электронной почты в случае срабатывания сигнализации. 

Примечание. 

Перед использованием этой функции удостоверьтесь, что настройка параметра Электронная 
почта выполнена. 

Enable Plan 

Установите флажок и задайте время начала и окончания детекции движения. Вы можете 
составить план, используя функцию перетаскивания мыши, и нажать Edit для изменения 
периодов времени в таблице. Периоды времени не должны перекрываться. Камера 
отправляет сигналы тревоги только в течение заданных периодов времени. 

Вы можете выбрать дни с понедельника по воскресенье и установить четыре периода в 
пределах каждого дня. 

 

 

Составление плана с использованием 
функции перетаскивания мыши  

Изменение периодов времени в таблице 

Примечание.  

Составление плана с помощью мыши поддерживается только для Internet Explorer версии не 
ниже 8.0. После составления плана на один день вы можете применить те же параметры к 
другим дням, используя операции Copy и Paste. 

 

7. Нажмите Save. 

Сеточное детектирование 

1. Нажмите Setup > Events > Motion Detection. Установите для параметра Detection Mode значение 

Grid. 

 

2. Области обнаружения на сетке могут иметь неправильную форму. 

3. Задайте чувствительность, при которой камера будет отправлять сигнал тревоги при обнаружении 

движения (сигналы тревоги можно просматривать на совместимом видеорегистраторе). 
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4. Настройка параметров сигнализации. 

 Suppress Alarm(s): после первого срабатывания сигнализации те же самые сигналы тревоги не 

будут отправляться в течение установленного времени. 

 Clear Alarm(s): если после первого срабатывания сигнализации, 

a. тот же самый сигнал тревоги не будет активирован в течение заданного времени, этот 

сигнал тревоги будет сброшен. После сброса отправка сигнала тревоги этого типа снова 

станет возможной. 

b. Если тот же самый сигнал тревоги будет активирован в течение заданного времени, этот 

сигнал тревоги не будет сброшен, пока не истечет время подавления этого сигнала. После 

этого тот же самый сигнал тревоги может быть отправлен снова. 

5. Укажите действия, которые запускаются по сигналу детекции движения, и составьте план. Для 

получения подробных сведений см. описания действий по сигналу тревоги в разделе Область 

обнаружения в Настройка параметров сигнализации детекции движения. 

6. Нажмите Save. 

Настройка параметров сигнализации о постороннем вмешательстве 

Настройте параметры сигнализации о постороннем вмешательстве, чтобы камера отправляла сигнал 

тревоги, когда объектив заблокирован в течение определенного времени. 

 

ПРИМЕЧАНИЕ! 

 Данная функция не поддерживается некоторыми моделями. Для получения подробных данных см. 
фактическую модель. 

 Действия по сигналу тревоги зависят от конкретной модели. Для получения подробных данных см. 
фактический веб-интерфейс. 

 

1. Нажмите Setup > Events > Common Alarm >Tampering Alarm. 

 

2. Выберите для параметра Tampering Alarm значение On. 

3. Установите чувствительность и период времени, при которых камера должна сигнализировать о 

постороннем вмешательстве. 

Чувствительность имеет на три уровня: высокий, средний и низкий. По сравнению с 

чувствительностью среднего уровня камера может обнаружить блокировку с более далекого 
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расстояния, когда установлен в высокий уровень чувствительности. Камера отправляет сигнал 

тревоги, когда объектив заблокирован в течение определенного времени. 

Сигнал тревоги о постороннем вмешательстве действует на весь экран. Для отключения 

сигнализации о постороннем вмешательстве снимите флажок Tampering Alarm. 

4. Укажите действия, которые запускаются по сигналу тревоги о постороннем вмешательстве, и 

составьте план. Для получения подробных сведений см. описания действий по сигналу тревоги в 

Настройка параметров сигнализации детекции движения. 

5. Нажмите Save. 

Настройка параметров сигнализации по звуку 

Камера может анализировать входные звуковые сигналы для обнаружения исключений. Когда 

громкость повышается или снижается относительно заданного предела, либо достигает 

определенного порога, камера отправляет сигнал тревоги и запускает заданные действия. 

Удостоверьтесь, что устройство аудиовхода надлежащим образом подключено к камере, а аудиовход 

включен в разделе Настройка параметров тревожного входа. 

 

ПРИМЕЧАНИЕ! 

 Данная функция не поддерживается некоторыми моделями. Для получения подробных данных см. 
фактический веб-интерфейс. 

 Действия по сигналу тревоги зависят от конкретной модели. Для получения подробных данных см. 
фактический веб-интерфейс. 

 

1. Нажмите Setup > Events > Common Alarm >Audio Detection. 

 
2. Выберите для параметра Audio Detection значение Enable. Выберите тип обнаружения и установите 

предел различия или порог. Для отключения тревоги по звуку снимите флажок Enable. 

В следующей таблице описаны некоторые из главных параметров. 

Параметр Описание 

Detection 
Type 

 Внезапное повышение: сигнал тревоги отправляется, когда громкость превышает 
предел различия. 

 Внезапное понижение: сигнал тревоги отправляется, когда громкость падает ниже 
предела различия. 

 Внезапное изменение: сигнал тревоги отправляется, когда громкость повышается 
или снижается относительно заданного предела различия. 

 Порог: сигнал тревоги отправляется, когда громкость превышает пороговое значение. 
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Параметр Описание 

Difference 

 Порог: После установки порога громкости сигнал тревоги отправляется, когда 
громкость превышает пороговое значение. 

 Различие: разница между двумя уровнями громкости. Сигнал тревоги 
отправляется, когда громкость повышается или снижается относительно заданного 
предела различия. 

Примечание. 

 Для измерения громкости звука используется шкала в области тревоги по звуку. 

 Результаты тревоги по звуку отображаются в режиме реального времени. В красной 
зоне показаны отправленные сигналы тревоги по звуку. 

 

 

 

3. Задайте действия по сигналу тревоги и расписание постановки на охрану в соответствии со 

своими требованиями. Для получения подробных сведений см. описания действий по сигналу 

тревоги в Настройка параметров сигнализации детекции движения. 

4. Нажмите Save. 

Настройка параметров тревожного входа 

Камера может получать сигналы тревоги от устройств сторонних производителей. Для использования 

этой функции сначала необходимо настроить следующие параметры для тревожного входа: порт, имя 

ScaleVolume

Difference

Шкала Громкость 

Различие 
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сигнала тревоги, тип сигнала тревоги (нормально замкнутый *N.C.+ или нормально разомкнутый *N.O.+) и 

время отправки сигнала тревоги. 

 

ПРИМЕЧАНИЕ!  

 Данная функция не поддерживается некоторыми моделями. Для получения подробных данных см. 
фактическую модель. 

 Действия по сигналу тревоги зависят от конкретной модели. Для получения подробных данных см. 
фактический веб-интерфейс. 

 

1. Нажмите Setup > Events > Common Alarm > Alarm Input. 

 

2. Выберите сигнал тревоги и присвойте ему имя. 

3. Выберите N.O. или N.C. в соответствии с типом тревожного входа устройства стороннего 

производителя. Например, если тревожный вход устройства стороннего производителя в 

нормальном состоянии разомкнут, вы должны выбрать N.O., чтобы камера могла получать 

сигналы тревоги с входа этого устройства. 

4. Укажите действия, которые запускаются по сигналу тревожного входа, и составьте план. Для 

получения подробных сведений см. описания действий по сигналу тревоги в Настройка 

параметров сигнализации детекции движения. 

5. Нажмите Save. 

Настройка параметров тревожного выхода 

После активации тревожного выхода при детекции движения (булевский сигнал), камера может 

вывести тревожную информацию на устройство стороннего производителя, если тревожный выход 

корректно настроен как нормально замкнутый (N.C.) или нормально разомкнутый (N.O.). 

Продолжительность работы тревожного выхода может быть изменена. 

 

ПРИМЕЧАНИЕ! 

Данная функция не поддерживается некоторыми моделями. Для получения подробных данных см. 
фактическую модель. 
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1. Нажмите Setup > Events > Common Alarm > Alarm Output.  

 

2. Выберите сигнал тревоги и присвойте ему имя. 

3. Установите статус N.O. (настройка по умолчанию) и задайте продолжительность сигнала тревоги. 

4. Укажите действия, которые запускаются по сигналу тревожного входа, и составьте план. Для 

получения подробных сведений см. описания действий по сигналу тревоги в Настройка 

параметров сигнализации детекции движения. 

5. Нажмите Save. 

 

ПРЕДУПРЕЖДЕНИЕ! 

Строго следуйте процедуре включения питания устройств во избежание повреждения компонентов 
камеры.  

1. Удостоверьтесь, что для типа сигнала тревоги выбрано значение Normally Open (настройка по 
умолчанию), а камера и устройство тревожного выхода выключены.  

2. После выполнения подключения включите сначала камеру, а затем устройство тревожного 
выхода. 

 

Сохранение данных на карте памяти 

 
ПРИМЕЧАНИЕ! 

 Эта функция не поддерживается некоторыми моделями и может работать по-разному в 
зависимости от модели. Для получения подробных данных см. фактическую модель. 

 Когда камера работает в автономном режиме, рекомендуется использовать локальную 
память. Когда камерой управляет центральный сервер, необходимо прекратить использовать 
локальную память, чтобы не допустить сбоя службы последующей записи в кэш. 

 

Настройка параметров локальной памяти 

Локальная память используется для сохранения видео и снимков непосредственно на карту памяти. 

Когда камера работает в автономном режиме, рекомендуется использовать локальную память. 
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Сохранение данных вручную 

Когда включен режим сохранения данных вручную, камера будет периодически записывать видео в 

реальном времени. 

1. Нажмите Setup > Storage > Storage. 

 
Для некоторых моделей камер страница отображается следующим образом. 

 
2. Активируйте локальную память и измените настройки в соответствии со своими требованиями. 

В следующей таблице описаны некоторые из главных параметров. 

Параметр Описание 

Storage 
Medium 

Тип ресурса хранения. 

Примечание. 

 Для форматирования карты памяти сначала отключите функцию сохранения 
данных на карте. Затем нажмите Format и OK для подтверждения. После 
завершения форматирования система перезагрузится. 

 Отображается информация об общем и свободном пространстве. 

Data 
Overwrite 
Policy 

 Перезапись: если на карте памяти не останется свободного пространства, новые 
данные будут записываться за счет периодического удаления существующих данных. 

 Останов: если на карте памяти не останется свободного пространства, новые 
данные не будут сохраняться на этой карте. 

Post-Record(s) 
Этот параметр определяет продолжительность записи после окончания тревоги в 
режиме записи по сигналу тревоги. 

3. Нажмите Save. 
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Расписание записи 

Если расписание записи активировано, камера записывает видео на карту памяти в течение 

заданных периодов времени. 

1. Нажмите Setup > Storage > Storage. 

 

Для некоторых моделей камер страница отображается следующим образом. 
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2. Выберите Planned Storage, а затем установите периоды, в течение которых камера должна 

записывать видео на карту памяти. 

3. Нажмите Save. 

 
ПРИМЕЧАНИЕ!  

 Расписание записи не работает, когда включен режим сохранения данных вручную. 

 Для просмотра записей с карты памяти см. Воспроизведение видео и его загрузка в локальную 
память. 

 

Настройка последующей записи в кэш 

При централизованном управлении камера может использовать карту памяти в качестве ресурса 

резервного копирования данных для центрального сервера управления. Если процесс сохранения 

данных с камеры в центральное хранилище прервется из-за нестабильного сетевого подключения, 

камера автоматически переключится в режим последующей записи в кэш и начнет сохранять видео 

на карту памяти. 

Если включен режим резервного копирования записи, камера может автоматически передавать 

видеозаписи, сохраненные на карте памяти в виде файла, в хранилище сервера резервного 

копирования, когда связь между камерой и этим сервером восстановится. 

 
ПРИМЕЧАНИЕ! 

Перед настройкой режима последующей записи в кэш для камеры проверьте нижеследующее. 

 Карта памяти надлежащим образом установлена в камеру. 

 Ресурс резервного копирования добавлен на центральном сервере. 

 Ресурс резервного копирования был выделен для камеры. 
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Отключение локальной памяти 

1. Нажмите Setup > Storage > Storage. 

 

Для некоторых моделей камер страница отображается следующим образом. 

 

2. Установите для параметра Edge Storage значение Disable (что приведет к отключению режима 

сохранения данных вручную) и задайте объем видео. 

3. Нажмите Save. 

Обслуживание системы 

 
ПРИМЕЧАНИЕ!  

Данная функция не поддерживается некоторыми моделями. Для получения подробных данных см. 
фактическую модель. 
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Безопасность 

Управление пользователями 

Существует два типа пользователей в данной системе. 

 Администратор (admin). Имя администратора по умолчанию: admin. Это имя не подлежит 

изменению. Администратор имеет все полномочия и может управлять всеми пользователями и 

устройствами. В этой системе может быть только один администратор. 

 Обычный пользователь, называемый «пользователем» в настоящем руководстве. Пользователь 

имеет право только просматривать живое видео и видеозаписи. В этой системе может быть до 

32 обычных пользователей. 

Вы можете добавить пользователя в интерфейсе управления пользователями (выбрав Setup > 

Security > User). 

После добавления пользователя вы можете изменить пароль путем ввода нового пароля или 

удалить пользователя путем удаления его имени. 

 
ПРИМЕЧАНИЕ! 

 Только администратор может изменять пароли. Изменение имени или пароля пользователя, 
который находится в системе, приведет к принудительному выходу этого пользователя из 
системы. Для последующего входа в систему необходимо использовать новое имя 
пользователя или новый пароль. 

 Только администратор может добавлять и удалять пользователей. Удаление пользователя, 
который находится в системе, приведет к принудительному выходу этого пользователя из 
системы. Удаленный пользователь не сможет войти в систему. 

 

Настройка безопасной передачи данных 

Настройте защищенный канал передачи данных для обеспечения безопасности. 

 
ПРИМЕЧАНИЕ!  

Данная функция не поддерживается некоторыми моделями. Для получения подробных данных см. 
фактическую модель. 

 

1. Нажмите Setup > Network > Port. 

 

2. Введите номер порта в текстовое поле HTTPS Port. 

3. Нажмите Save. 

4. Нажмите Setup > Security > Network Security > HTTPS. 

 

5. Выберите для HTTPS значение On. При необходимости вы можете импортировать 

пользовательский сертификат SSL. 

6. Нажмите Save. 
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Чтобы перейти в режим защищенного канала, при следующем входе в систему введите адрес в 

следующем формате: https://IP-адрес:номер портаHTTPS, например: https://192.168.0.13:443. Если 

вы используете порт HTTPS по умолчанию, введите https://IP-адрес. 

Аутентификация  

Протоколом прикладного уровня является RTSP (протокол потоковой передачи в реальном времени). 

Чтобы передавать аудио/видеосигналы и управлять ими, установите аутентификацию RTSP в 

веб-интерфейсе. 

1. Нажмите Setup > Security > Network Security > Authentication. 

 

2. Выберите режим аутентификации и нажмите Save. 

Скрытие информации поставщика 

Вы можете скрыть информацию поставщика сетевой камеры в веб-интерфейсе. 

1. Нажмите Setup > Security > Registration Info. 

 

2. Установите для параметра Registration Info значение On. 

3. Нажмите Save. 

Привязка ARP 

Эта функция защищает камеру от атак ARP. Прежде чем ПК сможет получить доступ к камере из 

другой сети, необходимо корректно задать шлюз и MAC-адрес. Если указан неверный MAC-адрес, ПК 

сможет получить доступ к камере только находясь в той же локальной сети. 

1. Нажмите Setup > Security > Network Security > ARP Protection. 

 

2. Установите флажок, чтобы включить функцию привязки ARP, и задайте MAC-адрес шлюза. 

3. Нажмите Save. 

Фильтр IP-адресов 

Используйте фильтр IP-адресов, чтобы разрешить или запретить доступ с заданных IP-адресов. 

 
ПРИМЕЧАНИЕ!  

Данная функция не поддерживается некоторыми моделями. Для получения подробных данных см. 
фактическую модель. 
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1. Нажмите Setup > Security > Network Security > IP Address Filtering. 

 

2. Для активации фильтра IP-адресов выберите значение On. 

3. Выберите режим фильтрации, а затем добавьте IP-адреса. 

4. Нажмите Save. 

 
ПРИМЕЧАНИЕ! 

 Если для параметра Filtering Mode выбрано значение Whitelist, тогда камера будет доступна 
только для добавленных IP-адресов. Если для параметра Filtering Mode выбрано значение 
Deny Access, тогда камера будет недоступна только для добавленных IP-адресов. 

 Максимальное число IP-адресов: 32. Каждый IP-адрес может быть добавлен только один раз. 

 Первый байт каждого IP-адреса должен быть 1-223, а для четвертого нельзя использовать 0. 
Например, следующие IP-адреса являются недопустимыми и не могут быть добавлены: 
0.0.0.0, 127.0.0.1, 255.255.255.255, 224.0.0.1. 

 

Политика доступа 

 
ПРИМЕЧАНИЕ! 

Включение функции удобного пароля не влияет на использование системы. Если вы отключите ее и 
войдете в систему с ненадежным паролем, появится страница с требованием изменить пароль. На 
этой странице не будет кнопки для отмены или закрытия. Пароль по умолчанию считается 
ненадежным. 

 

1. Нажмите Setup > Security > Network Security > Access Policy. 

 

2. Чтобы активировать TELNET, удобный пароль и аутентификацию MAC, выберите значение On. 

3. Нажмите Save. 

Водяной знак 

Используйте водяной знак для шифрования пользовательской информации в видеозаписи, чтобы 

предотвратить ее несанкционированное удаление или изменение. 

 
ПРИМЕЧАНИЕ! 

Не все модели камер поддерживают эту функцию. 
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1. Нажмите Setup > Security > Watermark. 

 

2. Выберите On, чтобы активировать водяной знак, а затем введите его контент. 

3. Нажмите Save. 

Установка системного времени 

Вы можете использовать следующие методы для корректировки системного времени устройства. 

Установка или синхронизация системного времени вручную 

1. Нажмите Setup > Common > Time, а затем откройте вкладку Time. 

  

2. Выберите метод синхронизации. 

3. Установите свой часовой пояс и системное время. Вы можете также нажать Sync with Computer 

Time для синхронизации времени камеры с временем ПК. 

4. Нажмите Save. 

Синхронизация с сервером NTP 

1. Нажмите Setup > Common > Time, а затем откройте вкладку Time. 

 

2. Установите для параметра Sync Mode значение Sync with NTP Server, а затем задайте IP-адрес 

сервера NTP и интервал обновления. 

3. Нажмите Save. Камера будет периодически синхронизировать время с сервером NTP. 

Установка летнего времени 

1. Нажмите Setup > Common > Time, а затем откройте вкладку DST. 

 
2. Выберите для DST значение On, установите время начала, время окончания и смещение летнего 

времени. 

3. Нажмите Save. 
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Настройка параметров серверов 

Интеллектуальный сервер 

Если высокочувствительной камерой управляет центральный сервер, вы должны настроить 

интеллектуальный сервер. 

 
ПРИМЕЧАНИЕ! 

 Не все модели камер поддерживают работу с интеллектуальным сервером. 

 Для использования снимков лиц необходимо задать параметры сервера TMS, на который 
загружаются снимки. 

 

1. Нажмите Setup > Common > Time, а затем откройте вкладку Intelligent Server. 

 

2. Укажите IP-адрес сервера TM и настройте другие параметры. 

3. Нажмите Save. 

Настройка режима последовательного порта 

Последовательный порт RS485 используется для обмена данными с устройствами сторонних 

производителей. Параметры последовательного порта на камере должны соответствовать 

аналогичным параметрам подключенного устройства стороннего производителя. 

 
ПРИМЕЧАНИЕ! 

Данная функция не поддерживается некоторыми моделями. Для получения подробных данных см. 
фактическую модель. 

 

Управление PTZ 

Для управления PTZ-камерой через устройство стороннего производителя необходимо установить 

для параметра Port Mode значение PTZ Control.  

Путем отправки команд PELCO-D, совместимых с управлением PTZ (панорамирование-наклон-зум), 

через порт RS485 вы можете управлять PTZ-камерой, не используя пульт управления PTZ. 

1. Нажмите Setup > System > Ports & Devices и откройте вкладку Serial Port. 
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2. Выберите опцию PTZ Control в выпадающем списке Port Mode. В следующей таблице описаны 

некоторые из главных параметров. 

Параметр Описание 

PTZ Protocol 

Установите протокол PTZ, который поддерживает канал. 

Примечание. 

 Вы можете настроить этот параметр только тогда, когда для параметра Port Mode 
установлено значение PTZ Control.  

 Когда для параметра PTZ Protocol задано значение INTERNAL-PTZ, камера может 
подключиться к внешнему контроллеру PTZ без использования последовательного 
порта (параметры последовательного порта отображаются серым цветом). В этом 
случае вам потребуется только подключить интерфейсы зума и фокусировки камеры 
к объективу, после чего вы сможете управлять PTZ как внутренним PTZ-устройством. 

PTZ Mode 

 Приоритет встроенной системы PTZ: при выборе этой опции камера сначала 
пытается управлять PTZ (панорамирование-наклон-зум) автономно вместо того, 
чтобы использовать внешний контроллер PTZ. Для операций, которые камера не 
может выполнить автономно, будет использоваться внешний контроллер PTZ. 

 Приоритет внешней системы PTZ: камера сначала будет управлять PTZ через 
контроллер PTZ, подключенный к последовательному порту. 

Примечание. 

 Вы можете настроить этот параметр только тогда, когда для параметра Port Mode 
установлено значение PTZ Control. 

 При выборе INTERNAL-PTZ для этого параметра всегда устанавливается значение 
Built-in PTZ Priority, потому нет смысла подключать камеру к внешнему контроллеру 
PTZ через последовательный порт. Если вы все же подключите камеру к внешнему 
контроллеру PTZ, он не сможет управлять камерой. 

 Выберите значение этого параметра в соответствии со своими требованиями. 
Удостоверьтесь, что соответствующие интерфейсы управления PTZ подключены 
надлежащим образом. 

Address Code 

Задайте код адреса для PTZ. 

Примечание. 

Вы можете настроить этот параметр только тогда, когда для параметра Port Mode 
установлено значение PTZ Control, а для параметра PTZ Protocol не установлено 
значение INTERNAL-PTZ. 

 

3. Нажмите Save. 
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Прозрачный канал 

Для обмена данными с устройствами сторонних производителей по прозрачному каналу используется 

последовательный порт RS485. Прозрачный канал используется в основном для открытой передачи 

данных между двумя устройствами. 

 
ПРИМЕЧАНИЕ!  

 Данная функция не поддерживается некоторыми моделями. Для получения подробных 
данных см. фактическую модель. 

 Удостоверьтесь, что для параметра Port Mode на вашей камере установлено значение 
Trans-Channel. 

 

1. Нажмите Setup > System > Ports & Devices и откройте вкладку Serial Port. 

 

2. Выберите опцию Trans-Channel в выпадающем списке Port Mode. 

3. Выберите для параметра Trans-Channel значение Enable. 

4. Введите целевой IP-адрес и номер порта (IP-адрес и номер порта, к которому подключается 

прозрачный канал). 

5. Нажмите Save. 

OSD 

Для отображения на экране информации устройства стороннего производителя необходимо 

выбрать экранный интерфейс (OSD) в качестве режима порта. 

Камера получает информацию от устройства стороннего производителя через последовательный 

порт RS485, транслирует полученную информацию, а затем отображает ее в экранном интерфейсе. 

 
ПРИМЕЧАНИЕ! 

Чтобы камера корректно транслировала информацию, полученную от устройства стороннего 
производителя, убедитесь, что информация, отправляемая этим устройством через последовательный 
порт, соответствует формату данных нашей компании. Для получения дополнительной информации, 
обратитесь к своему дилеру. 
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1. Нажмите Setup > System > Ports & Devices и откройте вкладку Serial Port. 

 

2. Выберите опцию OSD в выпадающем списке Port Mode. Выберите Enable OSD Report (чтобы 

данные экранного интерфейса загружались на платформу). 

3. Нажмите Save. 

Прозрачный канал ONVIF 

Вы можете организовать обмен данными через прозрачный канал (ONVIF) между портом RS485 

камеры и устройством стороннего производителя. 

1. Нажмите Setup > System > Ports & Devices и откройте вкладку Serial Port. 

 

2. Установите для параметра Port Mode значение Select Trans-Channel via ONVIF. 

3. Нажмите Save. 

Управление стеклоочистителем 

Перед управлением стеклоочистителем необходимо настроить его параметры. 

 
ПРИМЕЧАНИЕ!  

Данная функция не поддерживается некоторыми моделями. Для получения подробных данных см. 
фактическую модель. 

 

1. Нажмите Setup > System > Ports и Devices и откройте вкладку External Device. 
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2. Задайте режим управления стеклоочистителем. В следующей таблице описаны некоторые из 

главных параметров. 

Параметр Описание 

Serial Port 
Стеклоочиститель управляется командами PELCO-D, поэтому для протокола PTZ 
необходимо выбрать опцию PELCO-D. Для получения подробной информации см. 
Управление PTZ. 

Alarm 
Input/Output 

Используйте тревожный вход/выход, чтобы замкнуть или разомкнуть цепь управления 
стеклоочистителем. 

 

Просмотр статуса устройства 

Вы можете просмотреть текущий статус своей камеры. 

1. Нажмите Setup > Common > Basic Info. 

2. Нажмите Refresh для получения последней информации о статусе. 

3. Просмотрите информацию об устройстве. 

Статус сохранения фотографий 

Вы можете просмотреть текущий статус сохранения фотографий. Для ознакомления с полной политикой 

сохранения данных см. Сохранение данных на карте памяти. 

 
ПРИМЕЧАНИЕ!  

Только модели с функцией сохранения данных поддерживают эту функцию. Для получения подробных 
данных см. фактическую модель. 

1. Нажмите Photo. 
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2. Нажмите Refresh для обновления статуса сохранения данных. 

3. Вы можете экспортировать или удалять фотографии в разделе Image List. 

Обновление ПО устройства 

Если устройством управляет центральный сервер, и вы хотите обновить ПО устройств в пакетном 

режиме, рекомендуется выполнить операцию обновления на центральном сервере. Для получения 

подробных инструкций см. руководство пользователя для центрального сервера управления. 

1. Нажмите Setup > System > Maintenance. 

 

2. В разделе Software Upgrade нажмите Browse и выберите файл обновления. 

3. Нажмите Upgrade, а затем подтвердите эту операцию для ее запуска. После завершения 

обновления система перезагрузится. Некоторые устройства поддерживают обновление 

программы загрузки. Для обновления выберите опцию Upgrade Boot Program. 

4. Вы можете нажать Detect для поиска новых версий, доступных для облачного обновления. 

 
ПРИМЕЧАНИЕ! 

 Вы должны использовать файл обновления, предназначенный специально для вашей 
камеры. Иначе могут возникнуть непредвиденные ошибки. 

 Обновление предоставляется в zip-архиве, который должен включать все необходимые файлы. 

 Программа загрузки загружает операционную систему, после чего система запускается. 
Функция обновления программы загрузки отключена по умолчанию, поэтому только камера 
будет обновлена до последней версии. Можно включить режим, при котором обновляются и 
камера, и программы загрузки, при этом может быть загружена операционная система 
следующих новых версий и последнее ПО для камеры. 

 Обеспечьте бесперебойное электропитание во время обновления. После завершения 
обновления система перезагрузится. 

 

Перезапуск системы 

1. Нажмите Setup > System > Maintenance. 

 

2. В разделе Device Restart нажмите Restart. Устройство перезапустится после подтверждения этой 

операции.  

 
ПРЕДУПРЕЖДЕНИЕ! 

Соблюдайте осторожностью при выполнении этой операции, потому что перезапуск системы 
приведет к прерыванию текущей работы. 
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Импорт и экспорт файла конфигурации системы 

Вы можете экспортировать файл текущей конфигурации камеры и сохранить его на ПК или на 

внешнем накопителе. Вы можете также быстро восстановить конфигурацию путем импорта в камеру 

резервных копий, сохраненных на ПК или на внешнем накопителе. 

 
ПРЕДУПРЕЖДЕНИЕ!  

 После выполнения операции сброса к настройкам по умолчанию (Default), заводские 
значения будут установлены для всех параметров, кроме следующих: пароль и логин 
системного администратора, сетевые настройки и системное время. 

 Удостоверьтесь, что вы импортируете корректный файл конфигурации для своей камеры. 
Иначе могут возникнуть непредвиденные ошибки. 

 Когда файл конфигурации будет успешно импортирован, камера перезапустится. 

 

1. Нажмите Setup > System > Maintenance. 

 

2. Для импорта сохраненных файлов конфигурации нажмите Browse рядом с кнопкой Import, 

выберите файл, который требуется импортировать, и нажмите Import. Результат будет показан 

на экране. 

3. Для экспорта файла конфигурации нажмите Export и выберите целевую папку. 

4. Для восстановления конфигурации по умолчанию нажмите Default и подтвердите эту операцию. 

Устройство перезапустится и восстановит конфигурацию по умолчанию. 

Сбор диагностической информации 

Диагностическая информация включается в журналы и конфигурацию системы. Вы можете 

экспортировать диагностическую информацию на ПК. 

1. Нажмите Setup > System > Maintenance. 

 

2. В разделе Diagnosis Info нажмите Export и выберите целевую папку. 

 
ПРИМЕЧАНИЕ! 

 Диагностическая информация экспортируется в локальную папку в форме сжатого файла. Вы 
должны распаковать файл с помощью архиватора, такого как WinRAR, а затем открыть файл с 
помощью текстового редактора. 

 Выбрав опцию Collect Image Debugging Info, вы можете в процессе работы просмотреть 
видео с отладочной информацией, что облегчает поиск неисправностей. 
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Параметры фокусировки 

Устройство может регулировать скорость автофокусировки в зависимости от минимальной дистанции 

фокусировки. Для четкой съемки рекомендуется, чтобы минимальная дистанция фокусировки была 

меньше, чем расстояние между объектами и объективом, например, если минимальная дистанция 

фокусировки составляет 3 м, тогда объекты, находящиеся ближе 3 м от объектива будут не в фокусе. 

 
ПРИМЕЧАНИЕ! 

Эта функция поддерживается только устройствами с автофокусировкой. Для получения подробных 
данных см. фактическую модель. 

1. Нажмите Setup > System > Maintenance. 

 

2. В разделе Focus задайте значения для параметров Min. Focus Distance (в см) и Max. Zoom Ratio. 

3. Нажмите OK. 

Высота установки устройства 

Введите фактическую высоту купола до земли, чтобы камера могла автоматически регулировать 

параметры инфракрасного светильника. 

 
ПРИМЕЧАНИЕ! 

Данная функция поддерживается только некоторыми моделями камер с инфракрасной подсветкой. 
Для получения подробных данных см. фактическую модель. 

1. Нажмите Setup > System > Maintenance. 

 

2. Введите фактическую высоту купола инфракрасного светильника до земли. 

3. Нажмите OK. 

Параметры камер FishEye 

Для качественного отображения видео необходимо настроить параметры объектива FishEye в 

соответствии с фактическим способом монтажа. 

 
ПРИМЕЧАНИЕ! 

Данная функция поддерживается только в моделях камер FishEye. Для получения подробных данных 
см. фактическую модель. 
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1. Нажмите Live View > Mount. Выберите способ монтажа. Выбранный способ монтажа должен 

совпадать с фактическим способом монтажа. 

 

 

Для некоторых моделей камер страница отображается следующим образом. 

 

 

2. Настройте параметры. В следующей таблице описаны некоторые из главных параметров. 

Параметр Описание 

 

 

 

 

Одиннадцать режимов отображения: 

 Оригинальное изображение 

 Панорамный вид 

 Панорама+3PTZ 

 Панорама+4PTZ 

 Панорама+8PTZ 

 Панорама 360°+1PTZ 

 Панорама 180° 
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Параметр Описание 

 

 

 

 

 

 

 

 Fisheye+3PTZ 

 Fisheye+4PTZ 

 Панорама 360°+6PTZ 

 Fisheye+8PTZ 

 

 

 

Три способа монтажа: 

 На потолке 

 На стене 

 На столе 

Примечание. 

Выбранный способ монтажа должен совпадать с фактическим способом монтажа. 

4  Трансляции в реальном времени 

Живой просмотр означает, что в окне веб-интерфейса отображается видео со звуком, получаемое с 

камеры в режиме реального времени. 

Если вы входите в систему с установленным флажком Live View, живое видео отображается по 

умолчанию. Вы можете дважды щелкнуть в окне просмотра, чтобы войти в полноэкранный формат 

или выйти из него. 
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Панель инструментов для живого просмотра 

 
ПРИМЕЧАНИЕ! 

Поддерживаемые функции живого просмотра зависят от модели камеры. Чтобы узнать, какие функции 
поддерживаются вашей камерой, см. веб-интерфейс. 

 

Кнопка Описание 

/  Воспроизведение/останов живого видео. 

 

Регулировка громкости выхода для медиаплеера на ПК. 

 

Регулировка громкости микрофона на ПК во время аудиосвязи между ПК и 
камерой. 

 

Создание снимка текущего изображения на экране ПК. 

Примечание.  

Путь для сохранения снимков можно выбрать в меню System Configuration. 

/  

Запуск/останов локальной записи. 

Примечание.  

Путь для сохранения локальных записей можно выбрать в меню System 
Configuration. 

/  Запуск/останов аудиосвязи между ПК и камерой. 

/  
Запуск/останов цифрового зума. Более подробную информацию см. в 
разделе Использование цифрового зума. 

/  
Запуск/останов фокусировки зоны. Более подробную информацию см. в 
разделе Использование фокусировки зоны. 

/  
Запуск/останов 3D-позиционирования. Более подробную информацию см. 
в разделе Использование 3D-позиционирования. 

 Отображение/скрытие панели управления PTZ. 

 

Установка соотношения сторон экрана. Например, для отображения 
высококачественных изображений в оригинальном формате 16:9 выберите 
опцию Scale, для отображения по размеру окна выберите опцию Stretch, а 
для отображения в соответствии с размером исходного изображения 
выберите опцию Original. 

 

Сброс уровня потери пакетов на ноль. 

Примечание.  

После перемещения курсора мыши в окно живого просмотра эта кнопка 
появляется на плавающей панели инструментов. 

 

Отображение информации об уровне потери пакетов и скорости передачи 
данных в нижней части окна. 

Примечание. 

После перемещения курсора мыши в окно живого просмотра эта кнопка 
появляется на плавающей панели инструментов. 

Нажмите эту кнопку, чтобы всегда отображать эту информацию. При 
следующем щелчке мыши информация будет появляться только тогда, 
когда вы перемещаете курсор над окном или в его в нижней части. Если 
курсор мыши зависает в окне приблизительно на 3 секунды или выходит 
из окна, информация исчезает. 
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Кнопка Описание 

 
Нажмите эту кнопку для открытия страницы настройки изображения.  

 
Отображение в полноэкранном формате. 

 

 

 

Выбор поддерживаемого камерой потока для просмотра видео в 
реальном времени: основного, дополнительного или третьего. 

 

Просмотр определенной области изображений 

Цифровой зум, фокусировка зоны и 3D-позиционирование позволяют получать более подробные 

данные об определенной части изображения. Цифровой зум увеличивает изображение с потерей 

качества, в то время как 3D-позиционирование увеличивает его без каких-либо потерь. 

Использование цифрового зума 

 
ПРИМЕЧАНИЕ! 

Поддерживаемые функции живого просмотра зависят от модели камеры. Чтобы узнать, какие 
функции поддерживаются вашей камерой, см. веб-интерфейс. 

 

1. На странице Live View нажмите значок  на панели инструментов. 

 

2. Нажав и удерживая кнопку мыши, переместите курсор сверху вниз (нарисуйте прямоугольник), 

чтобы задать область. Чтобы восстановить размер исходного изображения и увеличить масштаб 

других его областей, щелкните правой кнопкой мыши. 

3. Чтобы выйти, нажмите значок . 
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Использование фокусировки зоны 

 
ПРИМЕЧАНИЕ! 

Поддерживаемые функции живого просмотра зависят от модели камеры. Чтобы узнать, какие 
функции поддерживаются вашей камерой, см. веб-интерфейс. 

 

1. На странице Live View нажмите значок  на панели инструментов. 

 

2. Нажав и удерживая кнопку мыши, переместите курсор сверху вниз (нарисуйте прямоугольник), 

чтобы задать область. 

3. Чтобы выйти, нажмите значок . 

Использование 3D-позиционирования 

 
ПРИМЕЧАНИЕ! 

Эта функция доступна только для сетевых PTZ-камер и корпусных IP-камер, оборудованных 
моторизированным объективом и системой PTZ (панорамирование-наклон-зум). Для получения 
подробных данных см. фактическую модель. 

 

  

https://tm.by 
Интернет-магазин



73 

1. На странице Live View нажмите значок  на панели инструментов. 

 

2. Нажав и удерживая кнопку мыши, переместите курсор сверху вниз (нарисуйте прямоугольник), 

чтобы задать область. Перетаскивание в обратном направлении (сверху вниз) уменьшает масштаб. 

3. Чтобы выйти, нажмите значок . 

Живой просмотр с камер FishEye 

 

ПРИМЕЧАНИЕ! 

 Данная функция поддерживается только камерами FishEye. Для получения подробных 
данных см. фактическую модель. 

 Изображение предварительного просмотра в сети может изменяться в зависимости от настроек 
камер FishEye. Перед запуском живого просмотра настройте параметры FishEye  
(см. Параметры камер Fisheye) и выберите режим FishEye (см. Конфигурация видео) для камеры.  

Есть три главных режима отображения: оригинальное изображение, Fisheye и PTZ, панорама и PTZ. 

При различных способах монтажа изображение отображается по-разному. Ниже показан пример 

крепления на стене. 

Когда выбран режим оригинального изображения, изображения FishEye отображаются, как показано 

ниже. 
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Когда выбран режим панорамы, развернутые изображения отображаются, как показано ниже. 
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ПРИМЕЧАНИЕ! 

Если выбран потолочный или настольный монтаж, панорамное изображение (два изображения с 
охватом 180°) представляет собой развернутую версию изображения предпросмотра FishEye (с 
охватом 360°). Установите камеру под соответствующим углом обзора согласно фактическим 
требованиям видеонаблюдения. 

Например, если камера устанавливается на потолке, цель наблюдения отображается в верхней 
части панорамного изображения, когда угол между кабельным выводом устройства (логотип) и 
целью наблюдения в направлении по часовой стрелке составляет 135°. 

 

 

 

Когда для предварительного просмотра в списке справа выбран режим Panoramic+4PTZ 

(панорама+4PTZ), по умолчанию отображаются 4 локальных изображения: слева направо и сверху 

вниз. Вы можете управлять PTZ и изменять зум для каждого локального изображения, как показано в 

рисунке ниже. 

 

LOGO

Cable 
outlet

45°

Position of surveillance target
(e.g. access control)

Target

Target

Device 
bottom

360° Fisheye image in 
fisheye preview mode

Panorama image in 
panorama preview mode

 Изображение в режиме 
предварительного 

просмотра FishEye (360°) 

Изображение в режиме 
панорамного 

предварительного 
просмотра 

Позиция цели наблюдения 
(например, управление 

доступом) 

Цель 

Кабельны
й вывод 

Нижняя 
часть 
устройства 
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5  Воспроизведение видео и его загрузка в 
локальную память 

 
ПРИМЕЧАНИЕ! 

 Под локальной памятью подразумевается запись видео на карту памяти интерфейсного 
устройства (главным образом камеры). Под локальной записью подразумевается запись 
видео посредством клиента локального ПК. 

 Перед воспроизведением видео из локальной памяти проверьте, что в камеру установлена 
картой памяти, а хранилище настроено. 

 Данная функция не поддерживается некоторыми моделями. Для получения подробных 
данных см. фактическую модель. 

Воспроизведение видео 

1. Нажмите Playback на домашней странице. 

 
2. Выберите дату в календаре. 

3. Нажмите Query. 

4. В разделе Results дважды щелкните период времени, чтобы начать воспроизведение записи. 

Загрузка 
1. Нажмите Playback на домашней странице. 
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2. Поиск видео в заданном периоде времени. Результаты будут показаны в списке. 

3. Выберите видео и нажмите Download. Видео будет загружено в локальную папку с карты 

памяти (путь к локальной папке может быть изменен в меню Local Settings). 

4. Нажмите Open, чтобы открыть папку, в которую было сохранено загруженное видео. 

6  Управление PTZ 

Эта функция доступна только для купольных PTZ-камер или корпусных камер, установленных на 

поворотно-наклонной платформе с электроприводом.  

 
ПРИМЕЧАНИЕ! 

 Некоторые функции управления объективом применимы к камерам, оборудованным 
моторизованным объективом. 

 Кнопки управления PTZ зависят от конкретной модели камеры. Чтобы узнать, какие кнопки 
управления PTZ поддерживаются вашей камерой, см. веб-интерфейс. 

Панель инструментов для управления PTZ 

Позиция Описание 

Preset 

Выберите предустановку и нажмите . PTZ-камера будет использовать 
выбранную предустановку. 

Для добавления предустановки нажмите . Для удаления предустановки нажмите . 

Patrol 

Выберите маршрут патрулирования, а затем нажмите  для запуска патрулирования.  

 Для изменения маршрута патрулирования нажмите . 

 Для добавления маршрута патрулирования нажмите . 

 Для удаления маршрута патрулирования нажмите . 

 

Установите скорость движения PTZ-камеры. 

 

Установите направление PTZ-камеры и отпустите кнопку управления. 

/  

/  

/  

/  

/  

Включение/выключение ИК-подсветки. 

Включение/выключение стеклоочистителя. 

Включение/выключение подогревателя. 

Включение/выключение освещения. 

Включение/выключение системы удаления снега. 
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Позиция Описание 

 

Фокусировка камеры. 

 

Изменение зума камеры. 

 

Увеличение/уменьшение диафрагмы. 

 

Кнопки быстрого доступа для управления PTZ. После того как курсор мыши примет 
одну из этих форм на экране живого просмотра, нажмите удерживайте левую 
кнопку мыши для управления PTZ-камерой. 

Примечание. 

 Только купольные и обычные PTZ-камеры поддерживают эту функцию. 

 Эти кнопки не действуют при использовании 3D-позиционирования или 
цифрового зума. 

 

Кнопки быстрого доступа для изменения масштаба изображения в режиме живого 
просмотра. Поверните колесико вперед, чтобы увеличить масштаб, или назад, 
чтобы уменьшить его. 

Примечание. 

Эту функцию поддерживают только камеры с моторизованным объективом. 

 

Установка патрулирования с помощью предустановок 

Задание предустановок 

На вкладке Preset вы можете управлять предустановками и выполнять определенные операции по 

управлению PTZ-камерой. Более подробную информацию см. в разделе Панель инструментов для 

управления PTZ. 

Добавление предустановки 

1. На странице Live View нажмите Preset на панели инструментов. 

 

 

1

2

3

4
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2. Измените положение камеры, чтобы она имела требуемое направление обзора. 

3. Настройте зум и фокус для получения оптимального изображения. 

4. Для добавления этих настроек в качестве предустановки нажмите . Введите номер и имя 

предустановки, а затем нажмите OK. 

Переход к предустановке 

1. На странице Live View нажмите Preset на панели инструментов. 

 

2. Чтобы перейти к предустановке, нажмите . PTZ-камера будет использовать выбранную 

предустановку. 

Удаление предустановки. 

1. На странице Live View нажмите Preset на панели инструментов. 

 

2. Нажмите  для предустановки, а затем подтвердите удаление. 

1 2

1 2
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Настройка патрулирования 

Маршрут патрулирования — это путь, которым следует PTZ-камера при перемещении от одной 

предустановки к другой. Отрезок времени, в течение которого PTZ-камера остается в каждой 

предустановленной позиции, можно изменить. Для PTZ-камеры можно задать несколько маршрутов 

патрулирования. 

Действия патрулирования включают движение к предустановке, остановку на некоторое время 

после достижения предустановки и движение к следующей предустановке. Вы можете задать 

направление вращения, зум, скорость вращения, время патрулирования и время остановки. Система 

записывает маршрут и добавляет его к списку действий. Вы можете выбрать режим Keep Rotating, 

чтобы PTZ-камера многократно следовала по одному и тому же маршруту патрулирования. 

Добавление маршрута патрулирования 

1. На странице Live View нажмите Patrol на панели инструментов. 

 

2. Нажмите . 

3. На странице Add Patrol введите идентификатор и имя маршрута, а затем нажмите Add для 

добавления действия патрулирования. Можно добавить до 64 действий. Когда выбран тип 

действия Move Direction и Zoom,каждая строка включает два действия, таким образом, можно 

задать только 32 двойных действия. Для изменения последовательности действий используйте 

соответствующие кнопки. 

Действия патрулирования включают: 

 движение к предустановке, остановку на некоторое время после достижения предустановки и 

движение к следующей предустановке; 

 поворот с заданной скоростью в заданном направлении в течение определенного промежутка 

времени, зум, остановку в заданном положении на определенное время или многократное 

патрулирование, если выбран режим Keep Rotating. 

Рекомендуется выбрать Go to Preset в качестве первого типа действия. 

4. Нажмите OK. 
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Запись маршрута патрулирования 

1. На странице Live View нажмите Patrol на панели инструментов. 

 

2. Чтобы начать запись маршрута патрулирования, нажмите . Вы можете изменять направление 

и зум камеры во время записи. Система записывает движения и маршрут камеры, а затем 

добавляет их к списку действий. 

3. Чтобы завершить запись, нажмите . После этого маршрут патрулирования автоматически 

сохраняется как предпочтительный. Вы можете нажать , чтобы запустить патрулирование, 

или , чтобы удалить предпочтительный маршрут. 

 

  

1

2
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Составление плана патрулирования 

1. На странице Live View нажмите Patrol на панели инструментов. 

 

2. Нажмите . Откроется страница для составление планов патрулирования. 

3. Задайте время и маршрут патрулирования. 

4. Выберите Enable Patrol Plan. 

5. Нажмите OK. 

Запуск маршрута патрулирования 

После добавления маршрутов патрулирования выберите маршрут для начала патрулирования. 

1. На странице Live View нажмите Patrol на панели инструментов. 

 

2. Нажмите  для маршрута патрулирования, который вы хотите запустить. 

  

1

2

1

2
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Изменение маршрута патрулирования 

1. На странице Live View нажмите Patrol на панели инструментов. 

 

2. Нажмите  для маршрута патрулирования, который вы хотите отредактировать, и измените 

настройки в соответствии со своими требованиями. 

Удаление маршрута патрулирования 

1. На странице Live View нажмите Patrol на панели инструментов. 

 

2. Нажмите  для маршрута патрулирования, который вы хотите удалить, и подтвердите 

удаление. 

Установка исходного положения 

PTZ-камера возвратится в исходное положение, если никакая операция не будет выполнена в 

заданный период времени. 

1
2

1
2
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ПРИМЕЧАНИЕ! 

 Эта функция доступна только для сетевых PTZ-камер. 

 Сначала вы должны добавить предустановку или маршрут патрулирования. Для получения 
подробной информации см. разделы Добавление предустановки и Добавление маршрута 
патрулирования. 

 

1. Нажмите Setup > PTZ > Home Position. 

 

2. Выберите режим и идентификатор. 

3. Нажмите Save. 

Дистанционное управление PTZ 

Когда используется сторонняя платформа, и протокол PTZ несовместим с ней, вы можете включить 

функцию дистанционного управления PTZ. 

 
ПРИМЕЧАНИЕ! 

Данная функция поддерживается только PTZ-камерами. 

 

1. Нажмите Setup > PTZ > Remote Control. 

 

2. Для активации функции Remote Control выберите On. Задайте порт прослушивания и код адреса. 

В следующей таблице описаны некоторые из главных параметров. 

Сокращение Описание  

Listener Port 
Локальный порт камеры, не занятый для других целей. Изменяйте 
настройку по умолчанию только при необходимости. 

Address Code 
Камера может найти код адреса, содержавшийся в командах. Камера 
выполняет команду только тогда, когда код адреса в команде совпадает 
с кодом адреса, который указан здесь. 

 

3. Нажмите Save. 

Предел PTZ 

Установите пределы вращения, чтобы PTZ-камера не столкнулась с препятствиями, такими как стены. 

 
ПРИМЕЧАНИЕ! 

Данная функция поддерживается только некоторыми моделями PTZ-камер. 
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1. Нажмите Setup > PTZ > PTZ Limit.  

 

2. Чтобы повернуть камеру в заданное положение, используйте кнопки со стрелками. 

3. Нажмите  для установки текущего положения в качестве предела. Например, нажмите  

вверху для установки верхнего предела. Нажатие значка  вызовет поворот камеры в текущее 

положение, если направление было изменено. 

4. Повторите вышеперечисленные шаги для установки всех пределов по мере необходимости 

(сверху, снизу, слева и справа). 

5. Нажмите Save. 

6. Нажмите Start PTZ Limit для применения настроек. 

7. Нажмите , чтобы сбросить настройки и установить предел заново. 

Возобновление патрулирования 

1. Нажмите Setup > PTZ > Patrol. 

 

2. Установите время возобновления патрулирования. 

3. Нажмите Save. 

 

 

1

2

3

4
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Приложение A. Глоссарий 

Сокращение Описание  

ARP Протокол преобразования адресов 

CBR Постоянная скорость потока 

DNS Служба доменных имен 

DDNS Динамическая служба доменных имен 

DHCP Протокол динамического конфигурирования узла 

DST Переход на летнее время 

FTP Протокол передачи файлов 

GOP Группа изображений 

GUI Графический интерфейс пользователя 

HTTPS Протокол передачи гипертекста по SSL 

IE Браузер Internet Explorer 

IMOS Мультимедийная операционная система IP 

IP Протокол межсетевого взаимодействия 

IPC IP-камера 

MTU Максимальная единица передачи 

NTP Сетевой протокол времени  

OSD Экранный интерфейс 

Порт PoE Подача питания по сети Ethernet 

PPPoE 
Метод передачи данных протокола одноточечных 
соединений через сеть Ethernet 

PTZ (панорамирование-наклон-зум) Поворот, наклон и зум 

ROI Область интереса 

SMTP Простой протокол пересылки электронной почты 

SSL Протокол защищенных сокетов 

UNP Универсальный сетевой паспорт 

Порт USB Универсальная последовательная шина 

VBR Переменная скорость потока 

WDR Широкий динамический диапазон 
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Приложение B. Часто задаваемые вопросы 

Что делать, если отсутствует сообщение с требованием установить ActiveX, когда я в первый раз 

вхожу в систему на ПК с Windows 7? 

Ответ: Выполните перечисленные ниже шаги, чтобы отключить UAC, а затем войдите в систему снова.  

1. Нажмите кнопку Start, а затем щелкните Control Panel. 

2. В окне поиска введите контроль учетных записей, а затем нажмите Change User Account Control 

Settings .  

3. Переместите бегунок в положение Never Notify, а затем нажмите ОК.  

4. После выключения контроля учетных записей снова войдите в систему. 

 

Что делать, если установка ActiveX закончилась неудачей? 

Ответ: Если установку не удалось выполнить, добавьте IP-адрес камеры в список надежных сайтов: 

откройте Internet Option в браузере Internet Explorer. Откройте вкладку Security, нажмите Trusted 

sites, а затем нажмите Sites для добавления веб-сайта.  

Если вы используете Windows 7, сначала сохраните файл setup.exe на ПК, а затем щелкните на этом 

файле правой кнопкой мыши, выберите опцию Run as administrator и установите программу в 

соответствии с экранными инструкциями. 

 

Что сделать, если при первом входе в систему не запускается режим просмотра видео в реальном 

времени? 

Ответ: Закройте брандмауэр на своем ПК, а затем снова войдите в веб-интерфейс. 
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